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Welcome to Axiom Rolling
Forecasting

Axiom Rolling Forecasting is an alternative to traditional budgeting that has gained widespread
acceptance among leading organizations in multiple industries. Rolling forecasting is a more dynamic
planning approach that either compliments your annual budget planning process or replaces the
traditional annual budget.

When performing annual budgeting, your organization can spend a lot of time and energy creating a
budget that is usually out-of-date before the process is completed. In contrast, Axiom Rolling Forecasting
allows you to incorporate previously unknown assumptions, new initiatives and other changes on a
monthly and quarterly basis. Amonthly/quarterly forecasting approach allows your organization to
navigate an environment of constant change with a more nimble, dynamic, and fluid process. This allows
you to adjust for factors that you might not have known about even a month ago. Moving from or
complimenting the annual budget process to rolling forecasts allows you greater flexibility in responding
to fluid situations.

Advantages of rolling forecasting include:

l Amuch quicker, less time-consuming process than traditional budgeting.
l The ability to respond to changes in a timelier (monthly/quarterly) manner vs. annual budget

process.
l Keep projections more in line with recent actuals.
l Focus on continuous improvement in key metrics.

The Axiom Rolling Forecasting process takes your actual data and rolls it horizontally into months and
quarters, projecting out themonths and quarters for the next two to three years. This process also
provides you the flexibility to roll up your organizational structure vertically into forecast categories, such
as Radiology, Surgery, and so on, instead of individual departments and grouping your account
structure into income statement categories (For example, Salaries, Supplies, Purchased Services, and so
on).

While Axiom is flexible and powerful enough to support any approach to financial management, the real
value of the software comes from Syntellis's library of healthcare-specific templates, reports, and utilities.
Based on our experience as trusted advisors to healthcare institutions, these tools can help your
organization establish and maintain the solid financial foundation necessary to fulfill its mission.

1
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Axiom Rolling Forecasting is supported by a team of specialists who together have helped hundreds of
healthcare organizations apply our solutions to meet their strategic and financial goals. During
implementation, a Syntellis implementation consultant will help you configure the application to match
your organization's structure and preferences. Afterward, feel free to contact Syntellis Support if you
encounter any difficulties or unanticipated situations while using the software.

What is covered in this document
This manual is written for end users (non-administrators) and covers the Axiom Rolling Forecasting
features. As an end user, you can view plan files and the following reports:

l Manager Dashboard
l Multi-Scenario Comparison
l Consolidated Summary
l EBIDA Summary
l Target Variance Report
l Month End Variance
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What’s new
Welcome to Version 2021.2 of Axiom Rolling Forecasting!

Enhancements in this release include the following:

New forecast methods available for IP_Census

The IP_Census calculation method is generally used for forecasting at the entity level. This calculation
method has been enhanced to providemore options for entity-level forecasting in the Revenue and
Expenses sections of the plan file Forecast worksheet.

Drill to details in theMonth End Variance report

You can now drill down to details on theMonth End Variance report if your system is integrated with
Axiom Performance Reporting. Drilling enables you to analyze the data at increasingly deeper levels to
help you determine the cause of each variance for report items that have an associated drill. Drill icons
indicate drillable data, making it easy to see wheremore detailed data is available.
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New forecast methods for IP_Census

� Why use this feature
If your organization uses plan files at a level higher than RFGroups, you now have additional forecast
methods to choose from when using the IP_Census calculation method to drive your revenue and
expenses.

� How this feature works
What: The IP_Census calculation method is generally used for forecasting at the entity level. This
calculation method has been enhanced to providemore options for entity-level forecasting in the
Revenue and Expenses sections of the plan file Forecast worksheet. The following have been added for
the listed calculation methods:

Calculation methods New options

Patient Revenue

Patient Revenue Net Per Unit

IP Admits\Discharge

CMI Inpatient Admissions

Expense

Salary

IP Admits\Discharge

IP Admits\Discharges Adj

CMI Inpatient Admissions

Where: This change applies to the statistics drop-downs in the Forecast Method column for the Patient
Revenue section and the Expenses section of the Forecast worksheet in the plan file template.

Who: This feature is available to all users who have plan file access.

How: Open the desired plan file. In the Patient Revenue section Expenses section of the Forecast
worksheet, select the desired forecast method. Save your work.
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� Where to find more information
The following topics in the online help have been added or updated with information and instructions for
using this feature:

l Forecast tab
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Drill to details in the Month End Variance report

� Why use this feature
You can now drill down to details on theMonth End Variance report if your system is integrated with
Axiom Performance Reporting. Drilling enables you to analyze the data at increasingly deeper levels to
help you determine the cause of each variance for report items that have an associated drill. Drill icons
indicate drillable data, making it easy to see wheremore detailed data is available.

� How this feature works
What: Easily drill from theMonth End Variance report to details in Axiom Performance Reporting. The
preconfigured drills enable you to view data from the department level all the way to revenue
transaction detail, provided there is data at each level to support drilling.

Where: This change applies to theMonth End Variance report available from the Admin and the Rolling
Fcsting task panes.

Who: By default, all Axiom Rolling Forecasting users who can access the report can access the drilling
feature.

How: Open theMonth End Variance report and select the RFGroup and view options, and then click
Apply. On the report, locate the variance problem areas on the report and check if a drill is available for
an item that you want to investigate. Line items with drills have a drill icon ( ) at the beginning of the
row. Click the drill icon to start drilling.

In the following example, arrows indicate a problem variance that has a drill.
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� Where to find more information
The following topic in the online help has been added or updated with information and instructions for
using this feature:

l Using theMonth End Variance report
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Understanding the Rolling Forecasting process
The Rolling Forecasting process generates forecasts for the next six to twelvemonths/quarters (two to
three years or up to 36months) using common budget and forecast techniques. Forecasts are calculated
using historical relationships to project the financial results of operations given current operating
relationships.

Rolling forecasting works as follows:

l The forecast is compared to the long-term financial plan as well as other targets.
l The resulting gap is analyzed to identify what changes in operations are necessary to move the

forecast so that it more closely matches the financial plan.
o Understand how your organization operates.
o Identify what needs to change today to close the gap.

The following is an example of a gap analysis graph:

The individuals who will interact with the Axiom Rolling Forecasting most often include:

l Rolling Forecasting Group Managers – Develop and update rolling forecasts to meet targets
based on the long-term financial plan as well as provide explanations for any significant variances.
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l Vice Presidents/Executives – Review reports and analyses of rolling forecast data to help inform
strategic decision-making.

If your organization is new to the rolling forecast process, you may encounter some resistance when
implementing the process because it represents a radical change in approach and philosophy. A few
questions and considerations:

l Is there executive support for rolling forecasting?
l Are there debt covenant or other requirements for a detailed budget?

o If you need a budget, it could be the annual plan from your long-range financial plan.
o Will industry benchmarks need to replace budget targets for biweekly/daily productivity?

l Do you have an extremely detailed budget process?
l Have you embarked upon a process improvement journey using such techniques as Lean

Accounting Total Quality Management, Kaizen, or Deming approaches?
l Have you introduced the concept of rate per unit to themanagement staff?
l Does themanagement staff have an understanding of fixed and variable cost?

o Flexible budget is a great tool to increase a manager's financial IQ.

l Are you interested in a monthly forecast to the end of the current fiscal year or a
monthly/quarterly forecast over a 12-quarter or 36-month time horizon?

o The CY Forecast utility is a good first step to organizational readiness for rolling forecasting.
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Getting Started
This section provides information on the basics of using Axiom Rolling Forecasting, such as:

l General system navigation and user interface
l Using spreadsheet plan files and report files from an end user perspective
l Using general Axiom spreadsheet file features such as views, snapshots, and printing
l Viewing data using web-friendly reporting tools such as Web Reports.

This section is intended for all users who are getting started with Axiom Rolling Forecasting. For end
users, this section provides an ongoing reference for file-related tasks.

Home page
All users have a home page that opens automatically when you log into Axiom Rolling Forecasting.
Depending on your system, theWeb Client home pagemay be one of the following:

l A product-specific home page for an installed Axiom Rolling Forecasting product
l A custom home page created specifically for your organization
l The default Axiom Rolling Forecasting home page

If you navigate away from the home page, you can return to it by using the Area menu in the Global
Navigation Bar:

Home option on Area menu

2
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If you are in a system with installed products, the Area menu may contain product names instead of the
Home item. In that case, you can select a product name to return to the home page for that product.

� Default home page
If a user does not have an assigned browser-based home page, then theWeb Client displays a default
home page. The default home page displays notifications, favorites, and quick links.

Example default home page

This default home page can also be accessed (by any user) by going to the following URL:

Example Cloud
URL

https://ClientName.axiom.cloud/Home/Launchpage

Where ClientName is the name of your Axiom Cloud system.

Example On-
Premise URL

http://ServerName/Axiom/Home/Launchpage

Where ServerName is the name of the Axiom Application Server, and Axiom is the
default name of the virtual directory.

This page has the following features:
l Notifications: You can read and delete notifications using the same features available in the

Notifications panel.
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l Quick Links: You can use a set of global quick links that are displayed here for easy access. These
links are built-in to the page and cannot be customized.

NOTE: Quick links to client applications only display if you have security permissions to launch
the application. If you do not have permission to any quick links, then the Quick Links section
is hidden on your home page.

l Favorites: You can open and delete web favorites.

Launching Axiom Rolling Forecasting applications
You can launch various Axiom Rolling Forecasting applications from theWeb Client Quick Launch menu,
including the Axiom Excel Client and AxiomWindows Client.

The Quick Launch menu serves the following purposes:
l Users can install applications from this area as needed. Afterward, they can continue to launch

installed applications from this location, or they can use other options (such as a shortcut on their
desktop).

l For systems using SAML or OpenID authentication, this is the only option for users to launch
installed applications. SAML and OpenID authentication require users to be authenticated using
theWeb Client before they can launch a desktop application.

l Users can install and launch add-ins such as the add-ins for Microsoft Office applications.

To open the Quick Launch menu, click the Quick Launch icon in the Global Navigation Bar.
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Quick Launch menu

NOTE: The specific clients and add-ins listed on the Quick Launch menu depend on your particular
security permissions (as defined on the Permissions tab of security). If you do not have permission
to a particular client or add-in, then that item does not display on the Quick Launch menu. If you do
not have security permissions to any of the applications on the Quick Launch menu, then the icon
and themenu will not be present in the navigation bar.

� Launching the Axiom Desktop Client
Using the Quick Launch menu, you can launch the Axiom Desktop Client. Click on one of the following
icons:

Item Description

Windows Client Launches the AxiomWindows Client on your desktop.

You must have theWindows Client Access security permission in order to see
this icon and launch the client. If you do not have this permission, theWindows
Client icon is hidden.

Excel Client Launches the Axiom Excel Client on your desktop. Requires Microsoft Excel.

You must have the Excel Client Access security permission in order to see this
icon and launch the client. If you do not have this permission, the Excel Client
icon is hidden.
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If the client is not already installed on the current workstation, clicking the icon will initiate the install and
then launch the client. If the client is already installed, clicking the link will launch the client. Your browser
must support ClickOnce in order to install and launch the client.

The appropriate client to use depends on your organization's preferences and on your user role. Your
organization will provide instruction as to which client you should use, and grant access to the clients as
needed.

For more information on installing theWindows Client and Excel Client, including prerequisites and
configuration details, see the Installation Guide (on-premise systems) or the Axiom Cloud Technical Guide
(Axiom Cloud systems). Some software prerequisites can be downloaded and installed from theWeb
Client. You can access the prerequisites download page from the Axiom Rolling Forecasting About box.

NOTE: The default home page also contains links to launch theWindows Client or the Excel Client.

� Launching add-ins
Using the Quick Launch menu, you can launch Axiom Rolling Forecasting add-ins. Click on one of the
following icons:

Item Description

MSWord Add-In Launches the Axiom Rolling Forecasting Add-In for Microsoft Word.

You must have theWord Add-In Access security permission in order to see this
icon and launch the add-in. If you do not have this permission, the icon is
hidden.

MS PowerPoint
Add-In

Launches the Axiom Rolling Forecasting Add-In for Microsoft PowerPoint.

You must have the PowerPoint Add-In Access security permission in order to
see this icon and launch the add-in. If you do not have this permission, the icon
is hidden.

TheWord and PowerPoint Add-ins are optional applications to support document integration between
Axiom Rolling Forecasting and Word or PowerPoint.

Navigation panel
Using the Navigation panel, you can navigate to your documents and to various areas of theWeb Client.

To open the Navigation panel, click themenu icon in the left side of the Task Bar. To navigate to an
area or document listed in the panel, click on the item.
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Example Navigation panel

The Navigation panel updates dynamically to show the available navigation links for the currently active
area of theWeb Client. The following areas are available:

Area Description

Default Axiom Rolling Forecasting provides a set of standard navigation links that show
by default when you are in theWeb Client. The previous screenshot shows the
standard navigation links. These links provide access to your favorites, recent
places, web-enabled reports and forms, and the Intelligence Center.

The standard navigation links can be customized, so each client's system may
look different. Navigation links can only be customized by administrators using
the Desktop Client.

System
Administration

The system administration links showwhen you are in the System
Administration area, and provide access to features such as the TableManager,
Audit Manager, and software updates.

Product-Specific Systems with installed products may have product-specific web navigation links.

When you select a product name from the Area menu in the Global
Navigation Bar., the product-specific links display in the Navigation panel. For
more information, see the product-specific documentation.

Additionally, when you open a report or other browser-based document, that document may be
associated with a set of document-specific navigation links. These links are added to the Navigation panel
while you are in that document.
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Viewing system information
Use the Axiom Rolling Forecasting About box to see information about your current system, such as:

l Axiom Rolling Forecasting version number
l Product version numbers
l System name
l Application server URL

The About box also contains a link to download software prerequisites, if necessary for installation of the
Desktop Client.

To open the About box:

1. Click themenu icon in the Global Navigation Bar.

2. At the bottom of the Area menu, click About Axiom Software.

About Axiom Software at bottom of Area menu
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Getting to know the interface
All Axiom products share a common interface and make use ofmany of the same features.

NOTE: The interface elements referenced in this section can vary depending on if or how your
organization customizes them. This means that topics in this manual may reference features that do
not display in your task panes, which means they may not be available for you to use. Contact your
Axiom administrator for more information.

The interface includes several sections, including:

� Display area
Themain display area displays the open files. By default, it shows the Syntellis Home dashboard, which
displays announcements, assigned tasks, links to dashboards, and contact information for
administrators. Your Axiom product administrator configures the information that displays on this
screen.
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� Task panes
A task pane provides access to commands, utilities, reports, plan files, and so on for Axiom Rolling
Forecasting, and displays on the left side of themain display area. To switch between task panes, click
the tabs on the left side of the interface. To expand or collapse the task panes, click the arrow in the left-
hand corner above the tabs.

Each Axiom product includes a set of specialized task panes. Different task panes display depending on
your security role profile. The administrator role profile has access to all of the features of Axiom Rolling
Forecasting, including drivers, dimension tables, and other system administrator features while the end
user task pane includes a subset of the options available in the Admin task pane.
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� Ribbon tabs
Ribbon tabs provide access to commonly used features and shortcuts to frequently accessed files. They
display above the task pane and main display areas. The role assigned to you determines the ribbon tabs
that display. For example, the Admin ribbon tab only displays to those users assigned the Administrator
role profile.

� Main
Includes commands for accomplishing most tasks in Axiom:
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l Opening, closing, and saving files
l Accessing online help for products and advanced (Axiom platform) help
l Viewing data in spreadsheets
l Printing or emailing files
l Accessing shortcuts to frequently accessed reports

� Admin
Includes commands for managing and configuring security, Scheduler jobs, processes, and data as well
as other system-related tools used by administrators. This ribbon tab only displays to users with
administrator privileges. Access to online help for products and advanced topics (Axiom platform) is also
available.

� Home
Includes standard spreadsheet commands.

Some options on the ribbon tabs display grayed out unless certain types of files such as reports or plan
files are currently open or if you do not have the necessary security permissions to use the feature.

The Excel Client displays all of the same ribbon tabs included in a normal Excel file. TheWindows Client
only includes a subset of the same ribbon tabs located in the Home ribbon tab.

TIP: When creating reports, we recommend that you use the Excel Client.
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AxiomAssistant task panes
The Axiom Assistant area provides quick and easy access to Axiom Rolling Forecasting files and features
as you work in the Desktop Client. A variety of task panes are available to help you perform general and
context-sensitive tasks. Additionally, system administrators can create customized task panes for use in
this area.

The Axiom Assistant area is located in the left-hand side of the application, below the ribbon and to the
left of any opened files. By default, the area is expanded, and you can work with any of its available task
panes by clicking the side-tabs along the left-hand edge of the pane.

Example Axiom Assistant area
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� Available task panes
The task panes available to you in the Axiom Assistant area depend on your system configuration and
your security permissions. The following task panes may be available:

Task pane Description Availability

Data Source
Assistant

Helper tool to build data sources, such
as RefreshVariables, DataLookup, and
Grid.

This task pane is system-controlled and
displays if you have the appropriate
security permissions, and the file is an
Axiom file.

Explorer Open files and other items that you
have access to, including favorites.

This task pane is included by default,
but may be disabled in your system or
restricted to only certain users.

File
Processing

Configure and perform file processing
for an Axiom file, such as to perform
multipass processing, file collect, or
batch processing.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is
enabled for File Processing.

Form
Assistant

Configure form settings for an Axiom
file, and preview the form.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is
enabled for Axiom forms.

Messages View comments about the current
document, and add comments.

This task pane is system-controlled and
displays for all eligible documents.

Notifications View alert and system notifications and
open associated files.

This task pane is system-controlled and
displays if you have any active
notifications.

Process View process information and complete
process tasks. By default this task pane
only displays if it is relevant to you (for
example if you are the assigned owner
of a process task).

This task pane is included by default,
but may be disabled in your system.

Sheet
Assistant

Configure workbook and worksheet
settings for an Axiom file, including
Axiom queries.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is an
Axiom file.

Table View table details, set a filter, and
refresh the currently opened table.

This task pane is system-controlled and
displays when using Open Table in
Spreadsheet.
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Task pane Description Availability

<Custom
Task Panes>

Your organization may have defined
one or more custom task panes for
your system.

Custom task panes may open
automatically when Axiom Rolling
Forecasting is launched, or you may
have access to the Task Panes Library to
open certain task panes as needed.

The order of task panes in the Axiom Assistant area cannot bemanually changed. Your system
administrator has specified an order for the task panes that open when the system is started. System-
controlled task panes display after these startup task panes.

� Minimize Axiom Assistant
By default, the Axiom Assistant area is maximized when you first start Axiom Rolling Forecasting. If
desired, you can minimize this area—for example, to gain more screen space while working on a file.
When minimized, the area displays as a thin strip along the left-hand side of the application, with one or
more side-tabs for each task pane.

You can expand the Axiom Assistant area to perform a task, and then minimize it again when you are
finished.

l To minimize the Axiom Assistant pane, click the button in the header.

l To expand the Axiom Assistant pane, click the button in the collapsed header, or click on one of
the task pane tabs.

Axiom Rolling Forecasting remembers the state of the Axiom Assistant (minimized or expanded) when
you exit the application, and will apply that state the next time you open Axiom Rolling Forecasting on
the samemachine.

It is not possible to completely hide the Axiom Assistant area when task panes are open, however, if no
task panes are open then the Axiom Assistant area is automatically hidden (and will automatically show
again when a task pane is opened).

� Opening task panes
In most cases, the task panes that you need to use will open automatically—you do not need to
manually open them.

l Certain task panes are configured to open automatically when Axiom Rolling Forecasting is
started, such as the Explorer task pane. These task panes are considered to be "global" task panes
that you may want to use at any timewhile you work in the system.

l Other context-sensitive task panes only open when using certain features. For example, the File
Processing task pane only displays when you open a file that is enabled for File Processing. There
is no need to manually open the task pane because it will always be available when it is relevant
(and assuming that you have security permissions to view it).
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If you have access to the Task Panes Library to open certain custom task panes as needed, then you can
open a task pane by double-clicking it in the Explorer task pane or the Axiom Explorer dialog.
Alternatively, one of your "startup" task panes might be used to open other task panes.

For example, you might have access to a Monthly Reporting task pane that details the steps you need to
do to run your monthly reports, and links to those reports. You wouldn't necessarily need this task pane
to be open at all times; instead, you would only want to see it when you are ready to process your
monthly reports. You could open the task pane as needed from the Task Panes Library or from another
custom task pane that links to it.

� Closing task panes
Most task panes cannot bemanually closed. Either they are global task panes that always apply, or they
are context-sensitive task panes that close automatically when the associated file or feature is closed.
Alternatively, you can minimize the Axiom Assistant area to "hide" all task panes and gain more screen
space for your open files.

If a task pane is closeable, then you can close it by clicking the X icon on the side-tab for the task pane. If
this icon is not present, then the task pane cannot be closed. Typically, only task panes that you open
manually can be closed manually, but in some cases you may also be able to close task panes that open
on startup.

� Using task panes in the Axiom Excel Client
When using the Axiom Excel Client, each file opens within its own window, and each windowmaintains its
own set of ribbon tabs and task panes. This means that as you switch windows, the set of task panes
available in each windowmay be different. For example:

l If you manually opened a task pane in one window, that task pane will only be present in that
window. It will not be present in other windows.

l The currently active task pane is managed independently for each window, so the active task pane
may change as you change windows. (This can also occur when using the AxiomWindows Client, if
you switch between files that have different default task pane associations. However, in the Axiom
Excel Client it may also happen when switching between files with the same default task pane
associations.)

l The current state of task panes is managed independently for each window. For example, if you
expand the Reports Library in the Explorer task pane in one window, that expansion will not be
present if you switch to a different window.
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Opening the Axiom Rolling Forecasting task panes
To open the Axiom Rolling Forecast task panes:

l For administrators, in the Admin ribbon tab, click Admin Task Panes, and select Rolling
Forecasting Admin.

l For end users, in theMain ribbon tab, click Open App Menus, and select Rolling Forecasting.
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Opening the Explorer task pane
Axiom Rolling Forecasting provides a built-in Explorer task pane so that you can quickly access your
favorites, recent items, and all the files that you have rights to access.

TIP: You can also access Favorites, Recent, and My Documents from theMy Files and Tasks task
pane.

By default, all users are given access to this task pane. If desired, administrators can disable use of this
task pane entirely, or restrict access to certain sets of users.

To access the Explorer task pane:
l In theMain ribbon tab, click Navigation, and select Explorer.

Managing favorites
You can save Axiom files and other items as favorites, for quick access to commonly used items. In the
Desktop Client, your favorites list is available in the following locations:

l The Explorer task pane in the Axiom Assistant area
l The Axiom Explorer dialog (if you have permission to access this dialog)
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When an item is saved to favorites, you can open the item by double-clicking it, or you can right-click it to
access any other commands that would be available on the item in its native area. For example, if you
have rights to the Table Library and you save a table as a favorite, you can right-click the table favorite
and perform actions such as editing the table structure.

If an item that a favorite points to is deleted, then the favorite becomes invalid and a red arrow icon
displays next to it. If you attempt to open an invalid favorite, a message box informs you that the item
has been deleted, and asks whether you want to delete the favorite. If a file is moved or renamed within
the Axiom Rolling Forecasting file system, but it retains the same document ID, then the shortcut will not
be broken.

� Saving and deleting favorites
You can save an item as a favorite in one of the following ways:

l In the Explorer task pane and the Axiom Explorer dialog, you can right-click an item and select
Add to Favorites.

l When a file is open, you can right-click the file tab and select Add to Favorites.

The item is saved as a favorite and now displays in your Favorites list. If the file was open when you saved
it as a favorite, it displays using the file tab name. If needed, you can change the display name by editing
the shortcut properties for the favorite.

TIP: If you open a table using Open Table in Spreadsheet, and then save the open table as a favorite
(using the file tabs), the settings you used will be automatically saved as part of the favorite, in the
shortcut properties. You may want to rename the favorite to indicate the particular settings (for
example: GL2021 - Filtered for North Region).

NOTE: If a web-enabled file is saved as a favorite in the Desktop Client, that favorite will also display in
theWeb Client. This includes Axiom forms and web reports. All other types of favorites do not display
in theWeb Client.

To delete a favorite, right-click the item and then select Delete.

� Organizing favorites
You can create sub-folders in the Favorites area to organize favorites by folder. To create a new folder,
right-click Favorites and select New Folder.

By default, favorites are displayed in the order that they were added (new favorites are added to the
bottom of the list). You can drag and drop individual favorites to change the order. Sub-folders cannot
be reordered—they will always display in alphabetical order.

To rename a favorite, right-click the item and then select Rename. The name becomes editable, and you
can type a new name.
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� Shortcut properties
You can edit the shortcut properties for a favorite. Right-click the favorite and select Shortcut Properties.
In this dialog, you can edit the shortcut name, change the shortcut target, and define certain shortcut
properties.

The available shortcut properties vary by file type. For example, you can configure a report favorite to
always open as read-only, or to automatically apply a Quick Filter when opening.

� Using web favorites in the Desktop Client
If you save a favorite in theWeb Client, that favorite also displays in the Desktop Client favorites list. You
can double-click the web favorite to open it in theWeb Client browser.

When a favorite is saved in theWeb Client, it is stored as a URL instead of a document shortcut. If the
target of the favorite is later deleted, the favorite does not show as invalid in the Desktop Client. If you
try to use the favorite, you are informed that the document or page cannot be found. In this case you
must manually delete the favorite.

Opening recent files
Axiom Rolling Forecasting maintains a list of your recently opened files in the Desktop Client. You can use
this list for quick access to recent files.

The recent file list is located in theMy Files section of the Explorer task pane and Axiom Explorer. You can
double-click files to open them, or right-click to access the context menu for the file type. Recent files are
listed using the file tab name that they were opened with, which may or may not be the same as the file
name.

The list displays the last 15 files that you recently opened. Note the following:
l If you want to clear the list, right-click Recent and select Clear History.
l If you want to continue to have quick access to a recent file, you can add it to your favorites.

Right-click the file and select Add to favorites.
l If the icon next to a file name is a red arrow, this means that the file has been moved or deleted

since you accessed it, so it can no longer be opened from the recent file list.

In the AxiomWindows Client only, recent files can also be accessed from the Filemenu. In the Axiom
Excel Client, although your recent files are tracked in File > Recent, those links point to the temporary
versions of the file stored on your local drive, not the source versions of the files stored in the Axiom
Rolling Forecasting database. Therefore, Excel's recent file list cannot be used to open Axiom files.
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Viewing notifications using the Notifications task pane
If you receive an Axiom Rolling Forecasting notification, the notification displays in the Notifications task
pane. This is a system-controlled task pane that is always available in the Desktop Client if you have
notifications. Click theNotifications tab in the Axiom Assistant area to view the task pane.

Example Notifications task pane

If you have unread notifications when you first log in, or if you receive new notifications during a current
session, the Notifications tab will flash orange and remain that color until you click on the tab. Unread
notifications display in bold text. Once a notification has been read, the bolding is removed.

Notifications can come from the following sources:
l Alert notifications. Your system administrators and other power users may have set up alerts to

monitor certain alertable conditions and then notify specified users.

l Process management notifications. These notifications result from active processes in process
management, such as to inform you that you have a new task in the process.

l Message stream notifications. If you have subscribed to a document's message stream, you will
be notified of any new comments made about that document.

l Axiom system processes such as Process Plan Files. If you have triggered certain system
processes, Axiom Rolling Forecasting will notify you when the process is completed or when errors
occur.

l Scheduler jobs. If you have run a Scheduler job manually and that job is configured to send
notifications, you will be notified when the job completes or errors (depending on the notification
configuration).
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NOTES:
l The Notifications task pane is a system-controlled task pane; you cannot hide or show this

task panemanually. The Notifications task pane always displays on startup if you have any
active notifications (read or unread). Otherwise, it does not display. If you receive a new
notification during a session and the task pane is not already open, this will cause the task
pane to open.

l All notifications displayed in the Notifications task pane are also available in the Notifications
panel of the AxiomWeb Client. Both areas read from the same source of notifications, and edit
the same source as well. So if you mark a notification as read in one area, or delete a
notification from one area, the other area will reflect these changes.

� Reviewing notifications
Within the task pane, notifications are listed in the order they were created, with the newest notifications
at the top. Each notification displays a severity icon and an alert title, as well as how old the notification
is. The following severity icons are used:

l Info

l Warning

l Error

To read the notification text, double-click the notification to expand it. The text should provide you with
more information about the notification and why you are receiving it. You can double-click the
notification again to collapse it.

If the notification is from an alert, then the alert creator may have specified a document that you can
open to seemore information about the alert condition. If so, then you will see an Open link underneath
themessage text when you expand the notification. Click this link to open the associated document.

� Notification actions
You can select one or more notifications and then right-click to perform the following additional actions: 

l Mark Read: Mark the selected notifications as read.
l Mark Unread: Mark the selected notifications as unread.
l GoTo Alert Definition: Open the source document for the alert, if you have permission to access

the file. You will be taken directly to the specific alert definition that generated the notification.
l Delete: Delete the selected notifications. Keep in mind that once a notification has been deleted,

you cannot undo this action.
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Changing your Axiom Rolling Forecasting password
If your authentication method is Axiom Prompt, you can change your password as needed using the
Desktop Client. This feature does not apply to users who are using any other authentication method
(such as Windows User Authentication), because those passwords are controlled externally from Axiom
Rolling Forecasting.

To change your password:
1. On the Axiom tab, in theHelp group, click Help > Change Password.

NOTE: In systems with installed products, this featuremay be located on theMain or Admin
tab.

This command is only available to Axiom Prompt users.

2. In the Set Password dialog, enter your current password, then enter and confirm your new
password.

If password rules are being enforced, your password must meet the rules. A validation message
will inform you of the rules if necessary. Alternatively you can click Generate Password to auto-
generate a password that meets the rules. If you do this, make sure to note the generated
password because you will not have another opportunity to see it. If you do not note the
password and cannot log in later, an administrator will need to reset your password.

3. Click OK.

Your password is now changed. You will need to use this new password the next time that you log in.

Closing Axiom Rolling Forecasting
When you close Axiom Rolling Forecasting, you will be prompted to save any changed but unsaved files.

To close the Desktop Client:
l Click the Close Axiom Software button in the Exit group of the Axiom tab.

NOTE: In systems with installed products, this button may be located on theMain or Admin
tab.

You can also close the application by clicking the X button in the top right-hand corner of the application
window.

If you are using the Axiom Excel Client, there is no option to close Axiom Rolling Forecasting but leave the
current Microsoft Excel session open. Keep in mind that it is not necessary to close Axiom Rolling
Forecasting in order to work on a regular Excel file. You can open regular Excel files within Axiom Rolling
Forecasting, or you can open a second Excel session.
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Understanding how Axiom Rolling
Forecasting works

Axiom Rolling Forecasting and the other Axiom products store data (financial data, labor data, key
statistics, and so on) in a central database, and then pull that data into the interface where you can view,
enter, or modify the data using familiar spreadsheet commands and utilities. This allows unmatched
flexibility for reporting and modeling your organization's finances without needing advanced
programming skills. Anyone with intermediate-level spreadsheet skills can master the Axiom Rolling
Forecasting core features.

Axiom Rolling Forecasting also uses spreadsheets, forms, and utilities to edit system configuration
settings and preferences for how data is stored, formatted, and calculated within the system.

File group
Axiom Rolling Forecasting organizes related files into file groups. Within a file group, files are stored in a
consistent folder structure and can share a common set of configuration settings, preferences, key
statistics, templates, scenarios, and calculation methods.

You can browse any of the file groups for which you have the necessary security permissions in the Plan
Files section of the Rolling Fcsting task pane.

3
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Plan files and drivers
In Axiom Rolling Forecasting, there is a file group for each forecast containing plan files (workbooks) with
financial data for each group. In addition, a scenario file displays configuration settings and rolling
forecast assumptions referenced by all of the plan files within the file group. For more information, see
Working with Plan Files.

Templates and refreshing data
Most of the data in Axiom is stored in a database. Plan files are typically generated as needed by
populating a template file with the relevant data from the database. Plan files in Axiom Rolling
Forecasting are virtual, which means they are not static copies in the database. Instead, they are created
upon open from a combination of themain plan file template, plan file groups, a selected scenario (which
contains driver settings), and additional data pulled from various data tables. If you need to update an
open workbook to reflect changes to the database or driver files, however, you can use the Refresh
feature.

NOTE: Only product administrators can create and modify scenarios.
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To refresh a plan file:
l On theMain tab, in theWorkbook Options group, click Refresh.

NOTE: You may be prompted to define values before the refresh occurs. If so, these values are
applied to the plan file to impact the data refresh.

Reports and utilities
Reports are spreadsheets or forms designed to help you review and analyze your organization's financial
data. Axiom Rolling Forecasting reports can query data from any table in the Axiom database. You can
find Axiom Rolling Forecasting reports in the Reporting section of the Rolling Fcsting task pane.

For more information, seeWorking with reports.
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Working with Plan Files
You use plan files to develop planning data and save that data to the database. In Axiom Rolling
Forecasting, the forecast data for each RFGroup is maintained in plan files, drivers, and scenarios.

Administrators create plan files for each RFGroup, and process the files to incorporate data. End users
develop and review existing plan files.

This section explains the basic concepts behind plan files and how to use them in the Desktop Client. This
section is intended for end users working with existing plan files, to develop and review plans.

In addition to the plan-specific functionality detailed in this section, you can use standard Axiom file
features and tools. Plan files use the same functionality as other Axiom files to perform actions such as
changing views or navigating to file bookmarks.

Opening Axiom Rolling Forecasting plan files
The forecast data for each RFGroup is maintained in plan files. Each plan file is a workbook with a series of
tabs, each with its own purpose. You access file groups from the Plan Files section of the RF Admin or RF
Fcst task pane.

When you open a plan file, you are prompted to select a scenario. After you select a scenario, the plan
file opens on the Summary tab; however, it may open on a different tab depending on where the plan file
was active the last time it was saved.

All plan file workbooks have a navigation pane that opens on the left of the workbook. You can use the
navigation pane to jump between tabs instead of clicking a tab at the bottom of the workbook.

In addition, the Navigation pane provides the ability to attach supporting files to plan files, and to save
your forecast to the database.

4
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To open Rolling Forecasting plan files:
1. In the RF Admin or Rolling Fcsting task pane, under File Group, double-click Open Plan Files.

2. In theOpen Plan Files dialog, select the plan file to open, and click OK.

3. In the Refresh Variables dialog, select a scenario, and then click OK.

The plan files workbook contains multiple tabs, which are covered in the following topics:

l Summary tab
l Plan tab
l Forecast tab
l Initiatives tab
l Forecast History tab
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Summary tab
This plan file worksheet compares the historical data and forecast projections for each month and
quarter, presented in monthly or quarterly columns (monthly includes quarterly), and indicates whether
each month’s or quarter's figures represent a favorable or unfavorable change from previous
months/quarters.

The Summary tab is divided into the following sections:

� Scorecard
The top portion of the tab is the scorecard section, which contains trend indicator icons for total key
statistics, revenue per unit, salary and benefits, and expenses.

TIP: You can hide the Scorecard section: in theMain ribbon tab, in the Change Viewmenu under
Row Views, clear the Show Scorecard check box.

The icons indicate the following:

l Green trend up – Favorable performance vs. the previous month/quarter
l Yellow trend flat – Unfavorable performance vs. the previous month/quarter
l Red trend down – Unfavorable performance vs. the previous two months/quarters

NOTE: Statistics and Revenue data use less than logic, while Salary, Benefits, and Expenses use
greater than logic.

Use the scorecard indicators to review trending patterns to identify anomalies in forecast values that you
may not see in themore detailed Forecast tab.

� Financial Summary
This Financial Summary section shows the profit and loss summary of the history and forecast results.
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� EBIDA and Key Statistics
These sections display the history and forecast results for each listed metric.

The EBIDA section displays the operating margin and the adjusted margin.

NOTE: The EBIDA section displays only if the display option is selected for this section in the Visibility
Options tab of the Configuration Utility.

The Key Statistics section displays Inpatient, Outpatient, and Other statistics, as applicable for the
selected plan file. In the following example, the EBIDA section is outlined in red; the Key Statistics section
is outlined in green.
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� Per Unit and Hours Analysis
These sections are part of the Financial Summary section, and contain a summary of the history and
forecast results for each listed metric. In the following example, the Per Unit section is outlined in red,
and the Hours Analysis section is outlined in green.

� Initiatives section
The Initiatives section in the Summary tab combines all approved initiatives from the plan file Initiatives
tab, with the same forecast columns as those used in the Forecast tab.

This section compares actual to forecast periods for all approved Initiatives, with the following sections:

l Financial
l EBIDA
l Key Statistic
l Expense per Unit
l Hours Analysis

Approved totals in this section should sum to the values from the Forecast columns on the Summary
tab.

To access the Initiatives section, scroll to the right in the worksheet, past the last forecast column.
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� Annual Comparison section
This section provides a payments-and-loss style overview of how your forecast values compare to your
historical data. In the first two columns are your last two completed fiscal years, followed by your Year to
Date actuals, and then the remaining total projection, which comes from the Forecast tab, as well as all
of the future forecasts summarized into the fiscal years.

Plan tab
This tab provides a questionnaire to aid in the planning process and provides the narrative
documentation to support your forecast, such as the narrative behind the numbers. Using the
questionnaire is a great way to ensure that you are discussing the right topics during the forecast
process.

End User's Guide Axiom Rolling Forecasting │ 44



On this tab, document what is important about this rolling forecast update and provide answers to
questions requested by the leadership team so that the responses can be referred to during the review
process.

To use this tab:
1. Open the desired plan file.

2. In the plan file navigation pane, double-click Complete Operating Plan.

3. Type your answers in the blue input cells. If you need more space than is provided, use the
Double click to Insert New Entry option to add a new line. You can add up to 5 additional lines.

4. In theMain ribbon tab, click Save.

For the answers from the Plan sheet to save back to the database, you need a valid RFID, RFCode and
RFGroup Dimension. The plan file assigns default codes for both the RFID and RFCode dimension tables
where these comments will be stored so that reports can be written to summarize these comments for
senior management review. The RFGroup Dimension gets assigned from the plan file where you wrote
your comments.

Administrators create questions for this tab in the Planning Questions tab of the Drivers utility. If the
questions are defined by RFPlanGroup, they will be sourced from the corresponding RFPlanGroup for the
selected scenario. If not defined by RFPlanGroup, the questions will come from the global block for the
selected scenario.
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Forecast tab
The Forecast tab is where all of the forecasting activity takes place by displaying historical (actual),
current, and forecasted values for volume, revenue, and expenses. All data columns appear with
monthly and quarterly values. You can hide or display monthly columns for each quarter. Quarter
columns are always visible.

If your organization uses Axiom Capital Tracking, capital projects may also be included at the bottom of
the worksheet in the Capital Tracking Projects block. This information only displays if your organization
has configured your system to import project spending data from Axiom Capital Tracking.

For the forecasted values, in the blue cells, update the values, as needed:

Column Description

[Section and row
names]

Contains row headings for each line item in each section.

Payor When Payor is used, this column displays the payor name.

Forecast Method Forecast methods available for a given section; the available items depend
on the associated driver used. Select the desired forecast method from the
drop-down provided.

Fixed / Variable % By default, the percentage that displays in this cell depends on the
Adjustments driver. In some cases you can input data.
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Column Description

Historical actuals by
month and quarter (6-
12 quarters may
display)

Quarter columns are expandable to showmonths in each quarter. To
expand the quarter, click the plus icon () in the header above the quarter
column.

Each section includes rows with blue input cells for entering adjustments.
For example, in the Volume > IP Visits section, you can enter a percentage
in the Growth Adjustment row.

[Current period] Current Actual period. This column is differentiated by a dark blue header,
and separates the past Actual period columns from the forecasted period
columns.

Forecast for the
future
quarters/months (6-
12 quarters may
display)

Quarters are displayed but can be expanded to viewmonths.

Type the forecasted amount for each quarter.

NOTE: If using monthly forecasting, you can plan down to themonthly
level for the current and next quarters.

Comments Enter any additional information, as needed.

� Variable Percentage type and amount
By default, the variable percentage is assigned using the Adjustments driver. The variable percentage
setting is located in the Variable Revenue rows in the Forecast Method column. You can select to use the
variable percentage set up in the driver or use the percentage from the prior forecast. The calculation
methods Expense, Other Revenue, and Salary, are affected by the variable percentage type and amount.

The Fixed Variable cell displays the percentage amount from either the driver or from the prior forecast.
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NOTE: You can update the percentage in the Fixed Variable cell, but once you enter a number, the
number you entered remains for the duration of that forecast. When you do your next forecast, the
number will display the default, and you can either leave the percentage as-is or you can change it
again for the duration of the forecast.

� Benefits and salaries
The total benefits for the following calc methods are calculated based on salaries from the Benefits Code
assigned to the Salary Code:

l Percent of Salary
l Rate Per FTE
l Salaries

Volume

Volume block and global volume drivers
Your forecast group can be affected by two different drivers: Global and Forecast Group Volume.

The leadership team defines the Volume Drivers to provide general guidance in terms of overall volume
growth. Historical volume statistics flow into the workbook, and they are initially projected based from
the Global Volume Drivers.

The following table describes the rows within the Volume block. Italicized row names in the table indicate
rows that are in a collapsible section of the Forecast worksheet.
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Row Description

[Volume
section
statistics]

Reflects historic volume for Actual columns, and computed volume for Forecast
columns. The calculation method drives the distribution of the forecast. The
forecast method can be:

l Calendar Days
l Work Days
l No Growth

Global Driver
Growth
Assumption

Reflects growth assumption from drivers for Forecast columns. Used in computed
Forecast volumes. As you review your volumes, consider how the global driver
may affect your forecast group volume.

[statistic] %
Change
excluding
Global Growth

Percent change from one period to the next. For Actual, compares historic
volume, for Forecast, compares computed volume. Drop-down selection controls
how forecast values are determined. Valid options include:

l Global Only – Volume ONLY. Uses the global driver inflation but ignores the
RFGroup historical growth rate.

l Last Month – Base forecast on themonth immediately prior to the current.
l Same Month – Base forecast on the samemonth for the previous year.
l 3 Month Avg – Base forecast on themonthly average for the last 3months.
l 6 Month Avg – Base forecast on themonthly average for the last 6months.
l 9 Month Avg – Base forecast on themonthly average for the last 9months.
l 12 Month Avg – Base forecast on themonthly average for the last 12months.

% Adjustment Manual entry adjustment % used to compute total volume.

Amount
Adjustment

Manual entry amount adjustment used to compute total volume.

Amount
Adjustment -
Quarterly

Quarterly manual entry amount adjustment used to compute total volume. The
manually-entered amount is allocated back to individual months in the quarter
that are forecast based on days.

Total -
[statistic]

Total of volume statistic. History for Actual columns; forecast periods are the local
statistic multiplied by the sum of the global and input % adjustments plus the
amount adjustments.

One Time
Adjustment
for Forecasted
Columns

Use for making one-time adjustments to individual forecast periods. Adjustment
affects only the specified period and not other future periods.

Total including
One Time
Adjustments

Sum of the Total volume plus the One Time Adjustment.
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Row Description

Prior Forecast Previously saved volume forecast.

Comments
(column)

The Comments column is the last column in the Forecast worksheet. If there is an
input cell in this column for one of the worksheet rows, you use these cells to
document your assumptions and reasons for making adjustments.

Revenue
The Revenue section usually consists of the following three subsections, although additional blocks can
be added as needed.

� Patient Revenue
For patient revenue, a block of rows displays similar to the Volume block for all categories of patient
revenue in your forecast group.

The following table describes the rows within the Patient Revenue block, and applies to the Inpatient
Revenue, Outpatient Revenue, and Other Patient Revenue subsections.

Italicized row names in the table indicate rows that are in a collapsible section of the Forecast worksheet.

Row Description

[patient] Revenue
volume

Displays the volume from the section above for reference

[Statistic] Forecast method selected from drop-down
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Row Description

Driver Inflation
Assumption

Inflation assumption from Drivers. Displays the price increase inflation taken
from the global assumptions

Inflation Adjustment Used for entering amounts to account for additional changes reflected in
your average rate per unit. You can use this to account for shifts in patient
acuity or changes in the types of services provided that would affect the
overall gross revenue

Period Over Period
Change

The amount of change from one period to the next

Revenue
Adjustment

Used for entering amounts to account for additional dollar changes
reflected in gross revenue

Avg Rate per Unit Displays the revenue-per-unit or themultiplied ratemultiplied by the
volume to calculate your gross revenue

Amount Adjustment
- Quarterly

Quarterly entry for adjustments. Entry gets allocated back to “forecast”
months in quarter based on days

Total – [patient]
Revenue

Displays the calculated gross revenue using the volumes multiplied by the
Avg. Rate per Unit

Volume OTA Used to compute impact of Volume OTA (in following row)

Impact of Volume
OTA

Themonetary impact of OTA calculated as the Cost per unit multiplied by
the number of OTA units

One Time
Adjustment for
Forecasted Columns

Manual entry to account for a one-time adjustment that affects only the
specified period and not other future periods

Total including One
Time Adjustments

Sum of Total [patient] Revenue and One Time Adjustment for Forecast
Columns

Period Over Period
Change

Amount of change from one period to the next

Percent of Patient
Revenue

Percent of Patient Revenue for forecast trended based on drop-down
selection. Default is 3Month Avg, other choices are: Global Only, Last
Month, SameMonth, 3,6,9,12month average

Net Revenue
Adjustment

Net revenue as a percent of gross revenue

Net [patient]
Revenue Per Unit

Net revenue per unit

Prior Forecast Data from the prior month/quarter

Comments (column) The Comments column is the last column in the Forecast worksheet. If there
is an input cell in this column for one of the worksheet rows, you use these
cells to document your assumptions and reasons for making adjustments
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NOTE: Depending on your accounting practice, you may see additional rows after the gross revenue
line to calculate deductions from revenue for your forecast group.

� Other Deductions (optional section)
The following table describes the Other Deductions block, and applies to the Bad Debt Allowances and
Discounts subsections. Italicized row names in the table indicate rows that are in a collapsible section of
the Forecast worksheet.

Row Description

[deduction]
Allowances

Displays the inflation taken from the global assumptions

Total Patient
Revenue

Total patient revenue amount

Driver Inflation
Assumption

Inflation assumption from Drivers. Displays the price increase inflation
taken from the global assumptions

Inflation Adjustment Manual adjustment for inflation for forecast periods

Total Inflation
Adjustment

The sum of the driver and manual inflation adjustments

Percent of Total
Patient Revenue

Deduction as a percent of total revenue

Deduction
Adjustment

Manual adjustment for deduction

Amount Adjustment -
Quarterly

Quarterly adjustment for deduction. Allocated back to forecast columns in
that month

Total - [deduction]
Allowances

Total deduction amount

One Time
Adjustment for
Forecasted Columns

Amount entered manually to account for a one-time adjustment that
affects only the specified period and not other future periods

Total including One
Time Adjustments

Sum of Total - [deduction] Allowances and One Time Adjustment for
Forecast Columns

Prior Forecast For actuals columns, this is blank. For current quarter columns, this is
either blank or previously saved amount. For forecast columns, this is the
previously saved amount

� Other Revenue
For Other Revenue, review the historical trending as well as the future forecast for each block.
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The following table describes the rows within the Other Revenue block. Italicized row names in the table
indicate rows that are in a collapsible section of the Forecast worksheet.

Row Description

Driver Inflation
Assumption

Displays the inflation taken from the assumptions

Inflation Adjustment Type inputs to account for additional changes to reflect in your inflation
rate

Total Inflation
Adjustment

l For Actual columns – (first row of historic actuals plus Revenue
Adjustment amount plus Amount Adjustment Quarterly) divided by
the prior month total

l For Current quarter – If column is "Actual", same as actual; otherwise,
this is the sum of Driver Inflation Assumption and Inflation Adjustment

l For Forecast columns – Sum of the Driver Inflation Assumption and the
Inflation Adjustment

Variable Rate Depends on selected Forecast Method. Total divided by units

Revenue Adjustment Manual entry to account for additional changes in other revenue reflected
in the forecast

Amount Adjustment -
Quarterly

Quarterly adjustment entry. Allocated back to "Forecast" months within
quarter

Variable Revenue Total revenueminus the Fixed Revenue

Fixed Revenue Displays the fixed portion of other revenue that will growwith inflation but
not volume

Adjusted Revenue for
Historical Trend
Calculations

Sum of Variable Revenue and Fixed Revenue
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Row Description

Total - Other
Operating Revenue

l For Actuals – From History in first row
l For Current Quarter – Sum of Fixed and Variable
l For Forecast – Sum of Fixed and Variable

One Time Adjustment
for Forecasted
Columns

Type inputs to account for a one-time adjustment that affects only the
specified quarter/month and not other future quarters/months.

Total including One
Time Adjustments

Total amount of Other Revenue plus OTA

Prior Forecast l For Actuals – Blank

l For Current Quarter –Month 1: Blank, Month 2& 3: If Actual, then
blank; otherwise, previously saved forecast

Comments A comments field is available at the end of certain rows. Type comments to
document your reasons for making entries/adjustments

Expenses
The Expenses section consists of the following blocks. Additional blocks can be added as needed.

� Salaries

The following table describes the rows within the Salaries block, and applies to the FTEs and Salaries, and
FTEs and Salaries - Contract Labor subsections. Italicized row names in the following table indicate rows
that are in a collapsible section of the Forecast worksheet.
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Row Description

[Statistic] Depends on the selection from the Forecast Method drop-down.

Variable Hours per Unit Displays the hours-per-unit rate that will drive your variable hours

Driver Productivity
Adjustment

Displays the productivity adjustment taken from the global
assumptions

Variable Productivity
Adjustment

Use to make a manual adjustment to account for additional percentage
changes to reflect in your hours per unit rate

Total Variable FTEs Net Variable FTEs. Total FTEs less productivity adjustments

Fixed FTEs Displays the fixed portion of your FTEs not adjusted for volume

Fixed FTE Adjustment Manual adjustment for Fixed FTEs in forecast periods

Amount Adjustment -
Quarterly FTE

Quarterly manual adjustment allocated back to "Forecast" months

Total Fixed FTEs Displays the sum of Fixed FTEs plus Fixed FTE Adjustments

Total FTEs Displays the sum of Variable FTEs plus Fixed FTEs plus FTE adjustment

Salaries

Driver Inflation
Assumption

The inflation rate from global drivers

Inflation Adjustment Use for entering amounts to account for additional percentage changes
reflected in your inflation rate

Period Over Period
Change

Amount of change from one period to the next

Salary Adjustment Use for entering amounts to account for additional dollar changes
reflected in your salaries

Amount Adjustment -
Quarterly Salary

Computed variable salary

Variable Salary Computed fixed salary

Total Salaries

Average Hourly Rate Displays the average hourly ratemultiplied by inflation adjustments

Cost per Unit Total salary dollars divided by the key statistic

One Time Adjustments
(OTA)

Title for the One Time Adjustments group of rows

Prior Forecast Amount from prior saved forecast

Comments (column) The Comments column is the last column in the Forecast worksheet. If
there is an input cell in this column for one of the worksheet rows, you
use these cells to document your assumptions and reasons for making
adjustments.
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� Benefits
Three different benefit calculations are available: Rate per FTE, Percentage of Salaries, and Expense.

Rates per FTE method

The Rate per FTE is used for benefits (for example, health insurance) where the number of FTEs drives the
cost.

The following table describes each rowwithin the Rate per FTE block:

Row Description

FTEs FTEs to which this benefit code relates based on drivers

Benefit Amount Historic benefit actual

Driver Growth Assumption Growth assumption from drivers - forecast only

% Adjustment Manual entry for all periods

Period Over Period Change Sum of the Growth Assumption and entered %Adjustment

Benefit Adjustments Manual entry for all periods

Rate per FTE Depends upon selected forecast method

Amount Adjustment -
Quarterly

Quarterly manual entry amount. Allocated to forecast months in
the quarter

Total - Benefits - Based upon
Rate per FTE

Sum of benefit cost

Cost per Unit Benefit cost per unit

One Time Adjustment for
Forecasted Columns

OTAmanual adjustment in Forecast columns only

Total including One Time
Adjustments

Total benefit cost plus OTA

Prior Forecast Previous forecast

Percent of Salaries method
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The Percent of Salaries is used for benefits such as pension that are driven by salary dollars.

The following table describes the rows in the Percent of Salaries block. Italicized row names in the table
indicate rows that are in a collapsible section of the Forecast worksheet.

Row Description

Salary Salaries to which this benefit applies

Benefit Amount Historical Actual

Driver Growth Assumption Growth from drivers for forecast periods. This gets added to the %
Adjustment in Period Over Period Change.

% Adjustment Manual entry adjustment for forecast periods

Period Over Period Change The amount of change from period to period

Benefit Adjustments Manual entry for forecast periods

% of Salaries Select from a drop-down of historical periods to use as a basis for
forecasting

Amount Adjustment -
Quarterly

Manual entry of quarterly adjustments

Total - Benefits - Based
upon Percent of Salaries

Total benefit cost

Cost per Unit Total - Benefits amount based on the Percent of Salaries divided by
number of units

One Time Adjustment for
Forecasted Columns

Manual entry to account for a one-time adjustment that affects only
the specified period and not other future periods

Total including One Time
Adjustments

Total cost including the OTA amount

Total Including Salary
OTAs

Total cost including OTA

Cost per Unit Cost per unit including OTA

Prior Forecast Previous forecast

End User's Guide Axiom Rolling Forecasting │ 57



Expense method

The Expensemethod takes the historical per unit rate and forecasts out based off of the forecasted
volume.

The following table describes each rowwithin the ExpenseMethod block:

Row Description

Total Key Statistic Key statistic used to drive variable expenses. Includes all payors if
applicable

Adjustments

Global Inflation
Assumption

Brings in statistic inflation adjustment from drivers

Inflation Adjustment Manual inflation adjustment entered as a percentage

Period Over Period Change Computed Total inflation adjustment

Expense Adjustment Manual expense adjustment by month, entered at dollars

Amount Adjustment -
Quarterly

Manual adjustment for the quarter. Spread back to the forcast
months in the quarter based on days

Variable Rate Variable rate per unit

Variable Expense Total of variable expenses

Fixed Expense Historic fixed expense based on percentage input. Forecast based on
periods selected in dropdown

Total - Benefits - Expense Displays the result of the expensemethod for total salaries (excluding
contract labor)

Cost per Unit Total cost per unit

One Time Adustments (OTA)

Volume OTA Computer volume one time adjustment

Expense OTA Manual entry for one time adjustment expense

Variable Expense Total variable expense including one time adjustment
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Row Description

Fixed Expense Total Fixed expense including one time adjustment

Total including One Time
Adjustments

Total expense including one time adjustments

Cost per Unit Including
OTA

Total cost per unit including one time adjustments

Prior Forecast Previous forecast

Add a one-time adjustment to a forecast
You can make one-time adjustments to your forecasts that affect only the desired month or quarter and
not other future periods.

In the plan file Forecast tab, when you add a regular adjustment to a forecast column, it is compounded
to the rest of the following forecasted months and quarters. However, when you add an adjustment in a
One Time Adjustment row, that adjustment affects only the period in which it is entered.

You can use the One Time Adjustment row in forecasted columns to adjust inserted statistics, revenue,
expense, and benefit items for all calculation methods.

To add a one-time adjustment:
1. In the desired section of the plan file Forecast tab, double-click the down arrow to the left of the

Total row, as shown in the following example:

2. In theOne Time Adjustment for Forecasted Columns row, for the desired quarter or month,
enter the adjustment amount in the blue cell.

Notice that only the Total including One Time Adjustments cell for the given period is affected.
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3. In theMain ribbon tab, click Save.

NOTE: To add adjustments that do compound into future forecasted columns, enter them in the
Adjustment row above the One Time Adjustment row in the desired section.

Initiatives tab
This tab tracks projections for initiatives that may or may not be added to the baseline forecast. This tab
is an optional configuration.

Your baseline forecast begins with historical actuals (same store operations). However, theremay be
some new initiatives or capital purchases with operating impact that may or may not be approved (e.g.,
Hospital expansion) that you might want to model the incremental volume, revenue, and expense
impact that may be used to determine whether or not the organization approves the project.
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If themonthly input columns are enabled for your workbook, you can use themonths that make up the
current and next quarter to more precisely plan initiatives, as shown in the following example.

Plan Initiatives on a monthly basis
You can forecast plan file Initiatives on a monthly basis for the current and next quarter, allowing you to
set more specific goals for initiatives.

The samemonthly columns available for the current and next quarters in the Forecast tab are also
available in the plan file RFInitiatives tab. Data entered into each month in a quarter is totaled for each
row and displayed in a quarter rollup column, as shown in the following example.

NOTE: The option to enter the current and next quarters by month is controlled in theWorkbook
Visibility driver located in the RF Driver utility. Users must have the Rolling Forecast Global Driver
Management role to make changes to this driver.
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Forecast History tab
This sheet provides historical data by months and quarters for the previous two years, the previously
submitted forecast, budget data, and, if you have Axiom Financial Planning, the current Financial Plan
data.
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Saving a plan file
After the workbook is complete, return to the Summary tab and assess the effect of your changes as well
as the financial impact on dollars, reviewing the per unit impact. If you are comfortable with the updated
forecast, you can save it.

To save a plan file:
l In theMain ribbon tab, click Save.

Updating data in plan files
Axiom Rolling Forecasting does not actually store data in any of the plan files within a file group. Instead,
these files pull data from the central database, allowing you to view and manipulate data within a
spreadsheet-style or form interface, and write the data back to the central database.

The practical implication of this structure is that changes made to a file in a file group will not be reflected
in other files (including copies of the same file opened by other users) until:

l Data in the file is saved back to the database, and
l Other impacted file(s) are refreshed with the latest data from the database (or, in the case of

configuration setting changes that alter the structure of other files, re-created from the original
scenario with the updated settings).

Most (but not all) files automatically refresh when opened.

Adding supporting files to plan files
Use these instructions to add supporting files to plan files.

To add files to plan files:
1. Open the desired plan file.

2. In the plan file navigation pane, double-click Add Supporting Files.
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3. In theManage Attachments dialog, click Upload Attachment, and then select the desired file. The
file is added to theManage Attachments dialog.

4. To add a description for the attachment:
a. Select the attachment, and then click Edit Description.

b. In the Edit Description dialog, type a description in theDescription field.

c. Click OK.

5. To view a file, select the file and then click Open. The file opens in a supported application
determined by the file type.

6. To delete a file, select the file and then click Delete. In the confirmation dialog, click Yes.

7. Click Close.
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Working with scenarios
A scenario is a named group of driver settings that you apply to plan files and other assets for forecasting
purposes. Scenarios allow you to create what-if situations to see how those forecasts would project with,
for example, different merits or revenue contract rate increases.

To use scenarios, apply the scenarios to your plan files and then compare the results.

If you do not create or manage scenarios, you can still use them every time you open a plan file or use a
report or utility that requires you to select a scenario on open.

5
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Select a scenario
Use these instructions to select a scenario from the Filters panel for Axiom Rolling Forecasting assets that
allow scenario selection.

To change the selected scenario:

1. Open the Filters panel if not already open (click the Filters icon ( ) in the page header).

2. In the Filters panel, from the scenario drop-down, select the desired scenario.

3. Click Apply.
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Working with reports
Reports use Axiom file functionality to bring in data from the database, and if desired, to save data back
to the database. You can use any Axiom file feature in a report except calc method libraries.

Report files, unlike other Axiom files, are not associated with any file group. You can bring in data from
any table. For example, if you have two file groups that are configured to save data back to two different
tables (or to different columns in the same table), you can use a report to compare the data.

� Report structure
Axiom reports are free-format. When you create a new report, you can use various query options to
bring data anywhere into the report, and you can use spreadsheet functionality to format the report and
calculate values such as subtotals and percentages.

Reports can have any number of sheets. Each sheet can be configured to bring in data from the
database, and, if desired, save data back to the database. If you want to use an Axiom query on a sheet,
or save data to the database from a sheet, that sheet must be configured on the Control Sheet. Other
Axiom file functionality, such as Axiom functions or GoTo bookmarks, do not require the sheet to be
configured on the Control Sheet.

� Reports Library
Report files are stored in the Axiom Software database. To make it easy to access and organize reports,
Axiom Software supports a virtual folder structure known as the Reports Library.

Each report is assigned to a folder in the Reports Library. When you open reports, you can navigate
through the Reports Library structure to quickly locate the report that you want to open.

The Reports Library is managed by using Axiom Explorer. If you are an administrator, or if you have
Administer Axiom Explorer rights, then you can use Axiom Explorer to create report folders, move reports
between folders, and delete existing reports.

You can also save reports outside of the Axiom Software database—for example, to your local computer
or to a network folder. In this case the file is considered to be a non-managed file. It is recommended to
maintain all reports as managed files unless you have a compelling reason to use a non-managed file.

6
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� Report output and distribution
In addition to the standard output options for Axiom files—such as the ability to take a snapshot of an
Axiom file—report files can use the File Processing feature.

Using file processing, you can refresh a report file and perform output and distribution actions such as
saving a snapshot copy of the file, emailing a snapshot copy of a file, or exporting data to a CSV/TXT file.
You can process the file "as is," or perform Multipass processing on the file, where the file is processed
multiple times using a unique filter for each pass.

NOTE: In reports with Excel’s expand/collapse feature enabled, snapshots need to be generated
using the Excel Client; otherwise, the columns will be hidden.

� Saving data to the database
In addition to viewing data, you can also use reports to calculate data and save data back to the
database. In certain circumstances, it may bemore appropriate to use a report to save data rather than
plan files or driver files. If a report file has been configured to save to the database, you can use the Save
button in the File Options group to save data.

Contact Syntellis Support if you are unsure about the best way to manage a certain set of data.

Browsing the Report Library
In addition to browsing the report folders in the Axiom Rolling Forecasting task panes, you can search all
of the available Axiom reports in the Reports Library.

To browse the Report Library:
1. In theMain ribbon tab, in the Reports group, click Reports > Browse All Reports.

2. In the Reports Library dialog, you can do the following:

l To sort, group, or search by any of the columns, click the drop-down arrow next to the
column label.

l To open a report, select it from the list, and click OK.
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Navigating reports
Axiom report files do not have a standard structure. Each report can have any number of sheets, layouts,
custom views, drill-downs, GoTo targets, quick filters, and associated task panes—all configured for the
specific information that displays.

Although not all of these features are available for every report, here is an overview of common report
features:

� Custom views
Custom views allow for different presentations of data within a report. For instance, a report might
default to showing monthly data but have custom views defined for displaying data by quarter or year.

NOTE: Not all reports have custom views defined.

If custom views have been defined within a report, you can access them by doing the following:

1. In theMain ribbon tab, in theWorkbook Options group, click Change View.

2. From themenu, select the view to use.

� Quick Filter
AQuick Filter is a temporary report filter. This allows you to quickly view the data at a different level of
detail, without needing to alter the report configuration. For more information, see the following:

l Applying a Quick Filter to a report
l Understanding hierarchy-based Quick Filters

� Drills
Some reports contain rows (or columns) where the data represents a roll-up of values for multiple
database records. For instance, an income summary report might combine patient revenue for all
departments into a single total for the year, or a report on payroll by department might roll up both
regular and non-productive hours into a combined number of hours for each department. In such cases,
you can use drills to view the individual values for each item included in the roll-up.

To drill in a report, do the following:
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1. In the report spreadsheet, select a cell.

2. In theMain ribbon tab, in theWorkbook Options group, click Drill.

3. From the drop-down, select any of the available drills to view a breakdown by that dimension or
value.

A new spreadsheet opens to display data at the specified drill-down level.

NOTE: While we havemade an effort to deactivate any drill options that do not apply to a particular
row/column/cell, there are simply too many possibilities for us to deactivate every invalid drilling
method for every cell in every report. As a result, certain drill methods may produce strange results.
For themost part, common sense should imply which dimensions or values you can drill for a given
roll-up (for example, drilling by Vice President on a single department might result in a report with a
single record, as a department typically has one VP assigned to it).

� GoTo targets
GoTo targets are simply bookmarks that allow you to jump to different sections of a report. Not all
reports include GoTo targets. To navigate to a target, do the following:

1. In theMain ribbon tab, in theWorkbook Options group, click GoTo.

2. From themenu, select the GoTo target.

Viewing a report
Axiom Rolling Forecasting reports are organized by folder in the RF Admin task pane or the Rolling Fcst
task pane. The specific report folders and files that you can access and the level of access rights depend
on your security settings. Administrators have full access to all reports.

When you first open a report, it is just an empty template that you need to populate with data. Some
reports automatically prompt you to select an account, department, scenario, or other variable. The
system then populates the report with related data from the database tables.

Other reports simply open as an empty template by refreshing the data. For more information, see
Refreshing a report with data.
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To view a report:
1. In the Rolling Fcsting task pane, in theGeneral Reporting section, navigate to the specific report

to open.

NOTE: Report folders may have sub-folders.

2. Double-click the report to open it.

3. To populate the report with data, see Refreshing a report with data.

The selected report opens. If a report is opened read-only, then the text (R/O) displays in the file tab. You
cannot save read-only reports.

NOTE: If another user has the report open as read/write, then you can only open the file as read-
only, regardless of your security permissions.

Saving a report
When you save a report, the report file is updated in the Axiom Rolling Forecasting file system. If the
report is configured to save data to the database, a save-to-database also occurs.

To save a report:
l On the Axiom tab, in the File Options group, click Save. (In systems with installed products, this

featuremay be located on theMain tab.)

Your file permission settings in Security determine whether you can save a particular report. If a report is
open with read/write permissions, then you can save it. If the report is open as read-only, then the
report file cannot be saved, but you may still be able to save data. You may also be able to save a copy of
the report.
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NOTE: Some files may use a Control Sheet setting that causes the data in the report to zero when the
file is saved. This is a security precaution that is normally enabled in reports only. You can click
Refresh to restore the data.

� Save-to-database reports
Some reports may be configured to save data to the database. If the report is configured to save to the
database, then the file is validated before saving. If errors are found, the file still saves but the data save
is stopped and the errors are displayed in the Save Errors pane. These errors must be corrected before
data can be saved to the database. If no errors are found, then a confirmation message displays, with
information about the number of records saved.

Your file permission settings in Security determine whether you can perform a save-to-database for a
particular report. Note that the permission to save data is managed separately from the file access
permission. Therefore, it is possible that you could have read-only permissions for the file, but still have
rights to save data (or the opposite—you could have read/write permissions for the file, but not have the
rights to save data).

When you click Save, Axiom Rolling Forecasting automatically performs all save actions that your user
rights allow and that the file is configured to perform. If desired, you can use the additional save options
to only save the file, or to only save data.

To save only the file:
l In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save File Only.

The plan file is saved. All save-to-database processes are ignored.

To save only the data:
l In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save Data Only.

Data from the file is saved to the database. The file itself is not saved.

NOTE: In systems with installed products, the additional save options may be located on theMain
tab. In all systems, you can also access these options by right-clicking the file tab.

� Saving a copy of a report
You can save a copy of a report using Save As features. You might want to save a copy of a report to use
as a starting point to create a new report, or to create an archive copy beforemaking changes to the
report.
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In most cases, you should save the report to the Axiom Rolling Forecasting file system (in the Reports
Library). However, it is possible to save report files outside of the Axiom Rolling Forecasting system (as
non-managed files). Non-managed files have limited functionality, and are not covered by Axiom Rolling
Forecasting security or included in system processes.

To save a copy of a report to the Reports Library:
1. On the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save As (Repository).

TIP: The Save As options are also available by right-clicking the file tab.

The Save As dialog opens, displaying the contents of the Reports Library.

NOTE: By default this dialog only displays files with the same file extension as the current file. If
you want to view all file types when using this dialog, select View > Show All Files. This setting
will be remembered.

2. In the left-hand side of the dialog, navigate to the folder in the Reports Library where you want to
save the file.

You must have read/write permissions to a folder in order to save a copy of the report there. A
lock icon displays next to folders where you do not have read/write permissions to any folder in
that folder tree.

3. In the File name box, type a name for the new report.

4. Optional. In theDescription box, type a description for the report.

5. Click OK.

To save a copy of a report locally (as a non-managed file):
1. On the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save As (Local File).

TIP: The Save As options are also available by right-clicking the file tab.

The Save As dialog opens.

2. Navigate to the desired location on your local computer or on a network file share, and then click
Save.

You can change the name of the file and its file format when saving. In the Excel Client, you can
save the file using any file format that your Excel version supports. In theWindows Client, you can
save the file as XLSM, XLSX, or XLS.
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Refreshing a report with data
To update a spreadsheet Axiom report with themost current data from the database, refresh the file. A
refresh does the following:

l Updates active Axiom queries with data, according to the update settings defined for the query
l Updates Axiom functions with data
l Performs an Excel calculation
l Reapplies the currently active views (if applicable)

To refresh a report:
l On the Axiom tab, in the File Options group, click Refresh.

This refreshes all sheets in the workbook. If you want to refresh the current sheet only, click the
down arrow on the right-hand side of the Refresh button, and then click Refresh Active Sheet.

In systems with installed products, this featuremay be located on theMain tab.

You may be prompted to define values before the refresh occurs. If so, these values will be applied to the
report to impact the data refresh.

TIP: You can also use F9 to refresh the entire workbook, and SHIFT+F9 to refresh only the active
sheet.

Applying a Quick Filter to a report
Using the Quick Filter feature, you can apply a temporary filter to a report. This allows you to quickly view
the data at a different level of detail, without needing to alter the report configuration.

For example, you may be viewing an Income Statement report for the entire consolidated organization,
and you want to view the same report at a different level of detail, such as for just North America or just
the South region. You can use the Quick Filter to recalculate the report at the desired level of detail, and
then clear the filter when you are done.

The Quick Filter is combined with your table security filters and any filters that are currently defined in
the report, such as sheet filters and filters defined for Axiom queries.

To apply a Quick Filter to a report:
1. On the Axiom tab, in the File Options group, click Quick Filter.
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NOTE: In systems with installed products, this featuremay be located on theMain tab.

2. At the top of the dialog, specify how the filter should be applied:
l Workbook (default): The Quick Filter is applied to all sheets in the workbook.
l Active Sheet: The Quick Filter is only applied to the currently active sheet.

This selection may determine which hierarchies and tables are available in the dialog to build the
filter. See Hierarchy and table availability in the Quick Filter dialog.

3. In theQuick Filter dialog, define a filter using one of the following methods:

l Data Hierarchies: Select the desired hierarchy levels(s) from the hierarchies listed in the
dialog. As you select items in the hierarchy, the corresponding filter is automatically built in
the Filter box.

For example, you might have a hierarchy named Geography, which has local regions rolling
up into countries, and countries rolling up into world regions. You can select the desired
items that you want to see in the report, such as Europe, Asia, or North America as world
regions. For more information and examples, see Understanding hierarchy-based Quick
Filters.

l Manual Filter: You can manually type a filter into the Filter box using standard filter criteria
statement syntax. Fully qualified Table.Column syntaxmust be used.

l Advanced Filter: Click Advanced Filter to create a filter using any reference table columns
(not just hierarchy columns).

Example Quick Filter dialog

4. Click OK.
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If the Quick Filter is applied to the entire workbook, a warning message informs you that the
entire workbook will be refreshed. If you do not want to see this message again in the future,
select Don't show this message again. Click OK to continue.

If the Quick Filter is applied to the current sheet, that sheet is refreshed and no warning message
appears.

If the file has been configured with GetCurrentValue("QuickFilter") functions, then these functions will
display the currently applied Quick Filter for your reference. If not, you can view the current Quick Filter
by clicking theQuick Filter button again. The current filter displays in the Filter box.

� Clearing the Quick Filter
Once a Quick Filter has been applied to a report, the filter remains applied until one of the following
occurs:

l The file is closed. Quick Filters cannot be saved in the file and are always cleared when the file is
closed.

l A newQuick Filter is applied by using theQuick Filter button and selecting a different filter.
l The Quick Filter is manually cleared. To clear the Quick Filter, click theQuick Filter button again

and then click Clear Filter.

� Hierarchy and table availability in the Quick Filter dialog
The hierarchies and tables shown in the Quick Filter dialog are based on the Axiom queries in the report.
Axiom Rolling Forecasting looks up the primary tables for the queries, and only shows the hierarchies
and reference tables that are relevant to those primary tables. This is done to help ensure that the Quick
Filter will be applicable to at least one query in the report.

If the filter applies to the entire workbook, then Axiom Rolling Forecasting looks at the primary tables for
all Axiom queries in the workbook. If the filter applies to the active sheet only, then Axiom Rolling
Forecasting looks at only the primary tables for the Axiom queries defined on the active sheet.

NOTE: In the Advanced Filter view, only reference tables are shown unless the primary table has
potentially ambiguous lookup relationships. In that case, the primary data table is also shown so
that the selections can bemade directly on these lookup relationships, to avoid any ambiguity. For
example, if the primary data table has columns PrimaryPhysician and SecondaryPhysician that both
look up to Physician.Physician, then the selection must bemade through the primary data table so
that the correct path to Physician.Physician is used.

If the report uses GetData functions instead of an Axiom query, then all hierarchies and reference tables
are listed in the dialog because Axiom Rolling Forecasting cannot determine the "primary table" in this
context. In this case, it is possible to define a Quick Filter that does not apply to any GetData functions in
the workbook. If this occurs, the filter will simply have no effect.
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� Understanding hierarchy-based Quick Filters
When you use hierarchies to create a Quick Filter, Axiom Rolling Forecasting automatically creates the
filter based on your selections. When only one item it selected, the filter is simple—only data that
matches the selected item is included. For example, if you select Asia from a Geography hierarchy, you
will get a filter something like: Dept.WorldRegion='Asia'.

Simple Quick Filter

NOTE: Sometimes when you select a single "child" item underneath a "parent" item, the child and
parent will be joined with AND. For example: DEPT.VP='Jones' AND DEPT.Manager='Smith'.
This means that the DEPT table has other instances ofManager Smith that belong to different VPs,
so the compound statement is to ensure that you only get the data whereManager Smith is under
VP Jones. (You can manually edit the filter to remove the Jones portion of the statement if you want
to see all data for Manager Smith, regardless of VP). If instead Axiom Rolling Forecasting constructs
the filter as just Dept.Manager='Smith', that means all instances ofManager Smith are also
under VP Jones.

You can select multiple items in the same hierarchy or from different hierarchies. Items from the same
hierarchy are combined using OR, which means data matching any of the selected items is included.
Items from different hierarchies are combined using AND, which means only data that matches both
selected items is included.
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Example 1

In example 1, we have selected two items from the same grouping level in a single hierarchy, so a simple
filter criteria statement is created using IN. The resulting filter will include all data from Asia and Europe.

Example 2
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In example 2, we have selected two items from different grouping levels, but within the same hierarchy.
In this case a compound filter criteria statement is created using OR. The resulting filter will include all
data that belongs to either Italy or US East.

Example 3

In example 3, we have selected two items from different hierarchies, so a compound filter criteria
statement is created using AND. The resulting filter will include only data that belongs to both US East
and VP David Prince.

Creating a new report
You can create a new report if you have read/write access to at least one folder in the Reports Library.
You can use any of themethods discussed below to create a new report. If you do not have these
permissions, then the associated menu options for creating new reports will not be available to you.

NOTE: After saving a new report to the Axiom file system, you may not see that new report displayed
in Axiom Explorer or the Reports menu until the file system has been refreshed. You can go to
Reports > Refresh file system to manually trigger a refresh and cause the new report to display.
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� Creating a new report using the Report Wizard
You can create a new report using the Report Wizard. In the wizard, you make selections regarding the
type of report that you want to create and the desired data, and then the wizard creates a report based
on your choices. You can then further modify the report as needed. For more information, see About the
Report Wizard in Help (Main ribbon tab >Help).

To create a new report using the Report Wizard:
l On theMain ribbon tab, in the Reports group, select Reports > Design Reports > Report Wizard.

� Creating a new blank report
You can create a new report from scratch using the default blank report template. This template is
entirely free-format.

If your organization has saved additional report templates, you can use those to create a new report as
well. Only administrators can create new report templates.

To create a new blank report:
l On theMain ribbon tab, in the Reports group, select Reports > Design Reports > New Report.

If your system has multiple report templates, you can select the template to use from this menu.
Otherwise, the default ReportTemplate is automatically used.

You can now use Axiom file functionality on this sheet, such as using Axiom queries to bring in data. For
more details on setting up Axiom files, see Axiom file setup in Help (Main ribbon tab >Help).

� Saving a new report
To save a new report, in the File Options group of theMain ribbon tab, click Save. When you save the
new report for the first time, you are prompted to define a file name and select a folder location in the
Reports Library. You can also define a description for the report.
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You must have read/write permissions to a folder to save a report there. A lock icon displays next to
folders where you do not have read/write permissions. If you have access to a My Documents folder,
you can also save reports there for your own use.

If you later want to change the file name, location, or description, you can use Axiom Explorer. If you do
not have rights to access Axiom Explorer, you can edit the description by using Save As (Repository)
(save the file with the same name and location, but edit the description).

You can also choose to save the report to your local drive or to a network location, by using Save As
(Local File). In this case the report is not stored in the Axiom Rolling Forecasting database and is
considered to be a non-managed file.

NOTE: Access to certain task panes (such as the Sheet Assistant) may depend on security
permissions defined at a folder level. When a new report file is created, the file location is assumed to
be the root of the Reports Library until the file is saved. Therefore access to task panes for brand new
reports depends on the user's permissions defined at the Reports Library level. If a user does not
have permission to the task panes at the Reports Library level but does have access at a sub-folder
level, then the user will not see the task panes until they save the file to that sub-folder.
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� Creating a new report based on an existing file
You can use Save As to create a new report based on a copy of an existing report. You can save the
copied file to the Reports Library, or as a local non-managed file.

You can also create a report based on an existing Excel file, by opening the Excel file in Axiom Rolling
Forecasting. To use certain Axiom file features such as Axiom queries, you must add a Control Sheet to
the report. For more information, see Control Sheets in Help (Main ribbon tab >Help). Then you can use
Save As (Repository) to save the file to the Reports Library.

Using the FilterWizard
The Filter Wizard is available throughout the system to assist you in constructing filters. The Filter Wizard
offers two different approaches for building filters:

l Hierarchies: Build a filter using hierarchies that have been set up for your system. You select the
items that you want to include and the Filter Wizard builds the filter criteria statement for you.

l Advanced Filter: Build a filter using any table and column that is relevant to the current context.
This approach also allows for more operators, including greater than, less than, and not equal to.

The Advanced Filter dialog has two versions, depending on how the dialog is launched. The
"desktop" version of the dialog is used in most places in the Desktop Client. The "web" version is
used in theWeb Client and with certain special features in the Desktop Client.

The Filter Wizard can be launched by using the Filter button in various dialogs and task panes. You can
also open the wizard manually from any cell in an Axiom spreadsheet file, using the right-click menu:
Axiom Wizards > Filter Wizard.

� Hierarchies
To create a filter using hierarchies, select the check box for each item that you want to include in the
filter. You can expand each hierarchy to see the items listed in it. You can also type a value into the filter
box above the hierarchies to filter the list.

For example, you may have a hierarchy for Geography that starts at theWorldRegion level, then goes
down to the Country level, and then goes down to the LocalRegion level. If you want to filter by a
particular country in the Asia WorldRegion, you can expand the Geography hierarchy, then expand the
Asia WorldRegion, and then select the desired country.
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As you select items, the filter criteria statement is created in the Filter box at the bottom of the dialog.
You can click OK to apply the filter as is, or you can manually edit the filter by typing in the box.

The hierarchies available to you are defined by your system administrator, based on grouping columns in
reference tables. If your system has no defined hierarchies (or if no defined hierarchies are relevant to the
current context), then theData Hierarchies section does not display, and the Advanced Filter opens
directly.

Note the following about filters created using data hierarchies:
l Only "include" filter criteria statements can be created using data hierarchy selections. As you

select items, those items will be included by using an equals (=) operator or an IN statement (for
including multiple items at the same level). If you want to write a filter criteria statement that
specifies items to exclude, or that uses other operators such as greater than or less than, then you
must use the Advanced Filter.

l Certain assumptions aremade regarding the use of AND and OR when multiple items are selected
from different hierarchy levels or different hierarchies. If you want to change the way each
statement is joined, you can manually edit the filter in the Filter box, or you can use the Advanced
Filter.
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l Sometimes when you select a "child" item underneath a "parent" item, the child and parent will
be joined with AND. For example: DEPT.VP='Jones' AND DEPT.Manager='Smith'. This
means that the DEPT table has other instances ofManager Smith that belong to different VPs, so
the compound statement is to ensure that you only get the data whereManager Smith is under
VP Jones. (You can manually edit the filter to remove the Jones portion of the statement if you
want to see all data for Manager Smith, regardless of VP). If instead Axiom Rolling Forecasting
constructs the filter as just Dept.Manager='Smith', that means all instances ofManager Smith
are also under VP Jones.

If an existing filter was present when the dialog was launched, this filter is listed in the Filter box. You can
manually edit this filter if desired, or you can make new selections to overwrite the current filter.

� Advanced filter (desktop version)
Using the desktop version of the Advanced Filter dialog, you can create a filter using any relevant table
and column, and using any supported operator. The desktop version is used in most areas of the
Desktop Client.

When using the desktop version, you can see a link in the top right corner named Simple Filter. Clicking
that link switches the dialog view to Hierarchy view. Once you are in Hierarchy view, you can switch back
to Advanced Filter view by clicking the Advanced Filter link in the top right corner. Only the desktop
version of the dialog supports switching between Advanced Filter and Hierarchies.

To create a filter using the desktop Advanced Filter dialog:
1. In the left-hand side of the dialog, select the table column on which you want to base the filter.

For example, if you want to create a filter such as DEPT.DEPT>=5000, then you must select the
DEPT column from the DEPT table.

To find the desired table and column, you can do the following:
l Use the View by option to view the list by table, table type, folder, or alias. Note that if you

want to select an alias, you must change the view to Alias—aliases are not listed under their
assigned table.

l You can also filter the list by typing into the filter box. The filter matches based on table
name or column name.

Once you select a table column, the values in that column display in the right-hand side of the
dialog.

TIP: Alternatively, you can use the folder icon to the right of the Preview box to load a
previously saved filter from the Filters Library. If you do this, your selected filter is placed in the
Preview box, overwriting any current content in the preview. Skip to step 4.

2. In the right-hand side of the dialog, type or select the value on which you want to base the filter.
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You can type into the box above the list of values to filter the list, or to specify a value. If one or
more values are selected, then those items are used in the filter. Otherwise, whatever is typed into
the box is used by the filter.

For example, you may want to create a filter such as DEPT.DEPT>5000, but 5000 is not an existing
value in the column. In this case, you can type 5000 into the box above the list of values. The filter
will use 5000 as the value.

If the column is a string, you can type an asterisk at the front or end of the value if you want to use
"ends with" or "begins with" wildcard matching.

NOTE: If the selected value is a Date or DateTime value, Axiom Rolling Forecasting will convert
the value to standard format if the current locale settings may result in an invalid or inaccurate
filter.

3. In the space between the two selection boxes, select the operator to use for the filter criteria
statement, such as equals, not equals, greater than, or less than. By default, the filter statement
uses equals (=).

Note the following about filter operators:
l Greater than / less than options are only available if the column data type holds numbers

or dates.

l If multiple items are selected, then IN and NOT IN syntax is automatically used for equals
and not equals respectively. Note that if the operator is equals but you select more items
than you have not selected, Axiom Rolling Forecasting will instead use NOT IN syntax for the
unselected items to simplify the filter statement.

l If the column is a string column, and you have typed a value rather than selecting it, then
LIKE and NOT LIKE syntax is automatically used for equals and not equals respectively. By
default, wildcard characters (% signs) are placed on both sides of the text, meaning that it
will match any value that contains the text. If you place an asterisk to the start or end of the
text, then the wildcard character will be only at that location.
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Example with wildcards

l If the column is a string column and the value contains an apostrophe (such as O'Connor),
the wizard automatically converts this value to double apostrophes so that it is valid for use
in the filter (O''Connor). Apostrophes in string values must be escaped this way so that they
are not interpreted as the closing apostrophe for the filter criteria statement.

4. Review the filter criteria statement in the Preview box to ensure that it is as intended. If you need
to make changes, edit your selections made above. The Preview box is not editable.

5. Do one of the following:
l If the filter criteria statement is finished, click OK. The filter wizard will use the statement in

the Preview box (you do not have to click Apply in this case).

l If you want to create a compound filter, click Apply to move the current criteria statement
into the Filter box. Then, repeat steps 1-4 to create another criteria statement. When the
next statement is complete, click either AND orOR to join it to the prior statement.

You can repeat this process as many times as necessary to create the desired statement.
You can also edit the full criteria statement within the Filter box as needed. When the entire
statement is complete, click OK.
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TIP: If you want to save the filter you have created for future use, click the save icon to the
right of the Filter box. You can select a folder location in the Filters Library (or My Documents if
applicable), and specify a name for the filter. This option is only available if you have read/write
access to at least one location where filters can be stored.

� Advanced filter (web version)
Using the web version of the Advanced Filter dialog, you can create a filter using any relevant table and
column, and using any supported operator. The web version is used by the following features: the
ShowFilterWizardDialog function, the AdvancedFilter refresh variable, and the Filter Wizard command
adapter. The web version is also used by the Filter Library when creating or editing a filter directly from
the library. The web version of the dialog is the same version that is used in theWeb Client.

The web version of the dialog has similar functionality as the desktop version, but there are a few
differences. Additionally, the web version of the dialog does not support switching to Hierarchy view.

To create a standard filter using the web Advanced Filter dialog:
1. In the left-hand side of the dialog, select the table column on which you want to base the filter.

For example, if you want to create a filter such as DEPT.DEPT>=5000, then you must select the
DEPT column from the DEPT table.

To find the desired table and column, you can filter the list by typing into the Search box. The filter
matches based on table and column names.

Once you select a table column, the values in that column display in the right-hand side of the
dialog.

TIP: Alternatively, you can use the folder icon to the right of the Preview box to load a
previously saved filter from the Filters Library. If you do this, your selected filter is placed in the
Preview box, overwriting any current content in the preview. Skip to step 4.

2. In the right-hand side of the dialog, select the value(s) on which you want to base the filter.

You can type into the filter box below the list of values to filter the list. Your current typed value is
always placed at the top of the list. You can select this typed value regardless of whether it
currently matches an actual value in the column. This behavior is to allow you to create a filter for
empty tables, or for tables where the value you want to filter on is not yet present in the column.
This is why you may see the "no matches" message but still have one value in the list—your typed
value.

3. In the space between the two selection boxes, select the operator to use for the filter criteria
statement, such as equals, not equals, greater than, or less than. By default, the filter statement
uses equals (=).
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Note the following about filter operators:
l Greater than / less than options are only available if the column data type holds numbers

or dates.

l If multiple items are selected, then IN and NOT IN syntax is automatically used for equals
and not equals respectively.

l If the column is a string column and the value contains an apostrophe (such as O'Connor),
the wizard automatically converts this value to double apostrophes so that it is valid for use
in the filter (O''Connor). Apostrophes in string values must be escaped this way so that they
are not interpreted as the closing apostrophe for the filter criteria statement.

l The LIKE operator is supported, but is not available for selection in the Filter Wizard. You
must manually edit the filter criteria statement if you want to use it. Only advanced users
with knowledge of valid SQL LIKE syntax should do this.

4. Review the filter criteria statement in the Preview box to ensure that it is as intended. If you need
to make changes, you can manually edit the statement, or you can start again with a new
statement. If you want to clear the statement, click the X icon to the right of the Preview box.

5. If no filter is currently present in the Filter box, click Apply to move the filter down to the Filter
box. If a filter is currently present in the Filter box, you can do one of the following:

l Click Replace to overwrite the current filter with the preview filter.
l Click AND orOR to add the preview filter to the current filter. This creates a compound

criteria statement.
You can repeat the filter creation process as many times as necessary to create the desired
statement. You can also manually modify the filter in the Filter box as needed, such as to add
parentheses to group statements.

6. When the filter in the Filter box is complete, click OK.

TIP: If you want to save the filter you have created for future use, click the save icon to the
right of the Filter box. You can select a folder location in the Filters Library (or My Documents if
applicable), and specify a name for the filter. This option is only available if you have read/write
access to at least one location where filters can be stored.

� Table and column visibility
Whenever possible, the Filter Wizard is context-sensitive, meaning that it only displays hierarchies and
tables that are relevant to the current context. For example, if you are defining a filter for a file group
permission set in Security, the Filter Wizard is limited to the plan code table (and any hierarchies defined
for that table).
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The available tables and columns in the Filter Wizard are also subject to the following settings:
l Security: If a user does not have any read access to a table, then that table does not display in the

Filter Wizard. If a user has filtered read access to a table, then the filter is applied to the values
displayed in the wizard.

l Column Properties: Individual columns in a table can be configured to be hidden in the Filter
Wizard, using the Is Filter Column setting. This may be used to hide columns that are unlikely to
be used in filters. Filters can still bemanually created using these columns; the properly simply
hides the column from the user interface, to streamline the column list.

Working with Report Processing
Some reports support automated processing. If so, the File Processing task pane displays collapsed on
the left side of the screen when you open the report.

NOTES:
l The File Processing menu command and the associated task pane are only available to

administrators or to users with the Allow File Processing permission for the current file.
l Other file types can be set up to use file processing, but themost common use is in a report.

You can use processing to perform the following actions:

l Save snapshot of file – Create a snapshot copy of the current file, and then save and/or email it.
l Save snapshot of form – Create a snapshot copy of a form-enabled file, and then save and/or

email it.

l Print – Print the current file, using one or more print views.
l Export to delimited text file – Export data in the current file to a delimited text file, and then save

and/or email it.
l Save data – Perform a save-to-database from the current file.
l Alerts – Process alert conditions defined in the file.
l File collect – Combinemultiple spreadsheet files into a single file, and then save and/or email it.
l Batch – Perform file processing on multiple files in a batch process, including the ability to override

certain file processing settings for the file.

One common use for file processing is report distribution, which allows you to automatically deliver
report files to multiple recipients. This frequently involves using several different features of file
processing, for example:

l Multiple reports configured for snapshot file processing and using Multipass processing. For
example, an income statement processed by department, region, or VP, and creating a separate
snapshot file for each element.
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l A report configured for file collect, to collect all of the snapshots into targeted report packages,
including adding things like cover sheets and other supporting information. These packages could
be saved to designated file locations and/or emailed to the appropriate recipients.

l A report configured for batch processing to run everything at once. For example, the batch would
contain an entry for each report configured for snapshot processing, and then finish with the file
collect report.

File processing is set up on a per-file basis. File processing can be set up on any Axiom file, but the
primary use case is in reports.

After the file has been configured to use file processing, you can process it by selecting an option in the
Main ribbon tab’s File Output section: File Output > File Processing. From this menu, you can choose to
Process File or Process File Multipass. File processing can also be performed using Scheduler and from a
task pane.

Processing a report
If a report is set up to use file processing, you can process the report to automatically perform actions
such as:

l Save snapshot copies of the file and automatically email them to various recipients
l Export data in the file to a CSV or TXT file
l Save data in the file to the database as part of a multipass process
l Collect multiple output files into a single report package
l Process multiple reports in batch

NOTES:
l The File Processing menu command and the associated task pane are only available to

administrators or to users with the Allow File Processing permission for the current file.
l Other file types can be set up to use file processing, but themost common use is in a report.

To process a file using file processing:
1. Open the file. If you want to see what the file is configured to do during file processing before

executing it, you can check the settings in the File Processing task pane.

2. In the File Processing task pane, in the Actions section, click one of the following options to start
processing:

l Process File: The file is processed once "as is." The file is refreshed and the file processing
action is performed. No multipass filter or settings are applied.

l Process File Multipass: The file is processed multiple times, with a unique filter applied for
each pass. For example, if the file is set up to process by DEPT, then the file is processed
once for each department. The data queries in the file are automatically filtered to return
data for the current pass department only.
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TIP: You can also process the file using the File Processingmenu on the Axiom tab. (In
systems with installed products, this featuremay be located on theMain tab.)

Once file processing is initiated, the following occurs:
l The file is refreshed. If you are performing multipass processing, the file is refreshed using a data

filter for the current pass item.
l The file processing action is performed. If you are performing multipass processing, the action

may be performed after each pass, or it may be performed once all passes are complete,
depending on the file processing settings.

A status bar displays the progress of the file processing. When the processing is complete, a confirmation
box displays information about the process, such as howmany passes were performed, howmany files
were created, etc.

Note that the file itself is not saved as part of file processing. You can process a file even if you have read-
only rights to the file. However, if the file processing is set up to save to the database, you must have
rights to save data for that file.

Working with the Manager Dashboard
TheManager Dashboard contains a series of interactive overview reports built specifically for people with
certain kinds of organizational user roles: executive, operational, financial, and analyst. Using the
dashboard, you can compare actual and forecast variance data by organizational performance,
operational revenue and expense data, and financial summary information.

� Opening the dashboard
Users must be assigned either the RF Admin, RF Analyst, or RF User role to use the dashboard.

To open the dashboard:
In the RF Admin or Rolling Fcsting task pane, under Reporting, double-clickManager Dashboard.

� Using the dashboard

IMPORTANT: Before using the dashboard, ensure the following:
1. Any recent changes made in the Dashboard Configuration Utility have been saved.
2. Actuals from the desired fiscal year(s) have been loaded.
3. Plan files have been created and processed.

TheManager Dashboard is comprised of the following areas:
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� Filters
Options on the Filters panel control the type and source of data displayed in the report for the various
tabs. The first two sections in the panel apply to the Executive Overview and the Credit Profile tabs. The
middle section applies to data in the Operational Overview tab. The selected scenario applies to all data
in all tabs.

In the Filters panel:
1. Under Executive Overview and Credit Profile Filters, select the group and related subfilter to

filter by.

2. UnderOperational Overview filters, select the RF Plan Group and a related RF Group.

IMPORTANT: Selecting an RF Plan Group and an RF Group are required for the Operational
Overview tab.

3. Under All Tabs Filters, select a scenario.

4. Click Apply.

To make changes to existing selections:
l To clear a single filter option, click the x next to the drop-down.
l To clear all the filter options, click Clear All.

The filter criteria detail you select display above the tabs:
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� Tabs
Report data is divided into threemain sections based on the data that users with certain roles would be
most likely to need:

l Executive Overview – Displays summary-level data and other overview-level data of your
organization’s performance. Subtabs provide summary, utilization, revenue, expense, and labor
data.

l Operational Overview – Displays revenue and expense data related to your organization’s
operations. Subtabs provide KPI data, patient revenue, other revenue, labor, benefits, and other
expenses data.

l Credit Profile tab – Displays financial summary information, margins, and asset liquidity. Subtabs
provide fiscal summary, profitability, and liquidity data.

� Statistics cards, and Key Performance Indicators (KPIs), and tables
The Executive Overview and Operational Overview tab reports have statistics cards at the top of each
subtab.

l In the Executive Overview tabs, the statistics cards display the dollar or percent variance between
actual and forecast data for each card’s given metric, plus a mini trend graph and KPI icon.

l In theOperational Overview tabs, the statistics cards display the actual and forecast amounts,
with the variance in large font. Negative variance amounts are enclosed in parentheses:
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l Some cards provide additional historical performance data in a table. To view historical
performance analysis, in the upper right corner of a card, click the showmore icon ( ):

l The Credit Profile tab reports display data in table rows instead of status cards. Click a table row
to view the data displayed as a bar chart. The following example shows the selected row
represented in the bar chart.

� Charts
In Executive Overview and Operational Overview reports, charts display variances in a graph for the
selected statistics card (exception: Operational Overview’s KPIs tab cards). Selected cards display with a
black background.
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l Hover your cursor over a bar in the graph to see the exact variance amount for that bar:

l In Operational Overview charts, you can select to hide the different metrics displayed: the bar
graph, which displays actuals; the line graph, which displays forecasts; or the gray shading behind
both that represents a 3-month or quarterly average, depending on whether you are set up for
forecasting monthly or quarterly.
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l Credit Profile charts display only actual and forecast data in a bar graph. You can toggle the blue
actual bars and the gray forecast bars on and off in the display, and like the other charts, hovering
your cursor over a graph bar displays the amount:

� Data and chart controls
The Executive Overview and Operational Overview tabs have display controls on the right side of the
page that control the time period and units used for calculations. To change the period or units displays,
click the corresponding toggle button.

l Executive Overview display options:

l Operational Overview display options:
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Comparing multiple scenario forecasts
Scenarios enable you to producemultiple forecasts while maintaining one set of plan files. TheMulti
Scenario Ratio Comparison Report enables you to view a comparison of selected scenario forecasts for
one or more RF Groups.

To compare multiple scenario forecasts:
1. In the RF Admin or Rolling Fcsting task pane, under Reporting, double-clickMulti Scenario

Comparison.

2. In the Filters pane, do the following:
a. Under Scenarios, select up to five scenarios from the corresponding drop-downs.

b. (Optional) Under RFGroup, select one or more RF Groups from the drop-down, and then
click OK.

NOTE: If you do not select any RF Groups, then all RF Groups are selected by default,
and the RFGroup name displayed at the top of the report will be “All.” If one RF Group is
selected, then the name of that RF Group displays. If more than one RF Group is
selected, then “Multiple” displays instead of a name.

c. Click Apply.

3. To control which report sections display, and whether to display historical actuals, do the
following:

a. In the upper right of the report, click Settings. The Settings dialog opens.

b. To include historical data columns in the report (up to 12 periods), under Additional
Columns, click the Previous Actuals toggle to Show.

c. To display a report section, under Show/Hide Statistics Sections, click that section’s toggle
to Show. To exclude a section, click that section’s toggle to Hide.

d. Click OK.
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4. To view or hide report data, in the body of the report, click the blue arrow icons ( ) to the left of
each section heading to expand or contract that section.

NOTE: In the report data, 0s (zeros) display as dashes. If you are using a quarterly model, then
quarterly columns will display instead ofmonthly.

5. To view the report with different scenario combinations, in the Filters pane, click Clear All, make
new selections, and then click Apply.

Using the Consolidated Summary report
The Consolidated Summary report provides transparency into your organization’s operations by
displaying a comparison of actual to forecast data that allows you to see trended information of the
forecast compared to prior results.

The comparison of actual to forecast is displayed in three primary views: (1) Annual, (2) Quarterly, and (3)
Monthly.

Additionally, views can be drilled into for more detail.
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The ratios at the bottom of the report add important analytics beyond the pure numbers. For example,
Benefits as a % of Salaries may show an anomaly that needs to be reviewed. Such an anomaly may not
be apparent from just the numbers alone.

To access the Consolidated Summary report:
1. In the RF Admin or Rolling Fcsting task pane under Reporting, double-click Consolidated

Summary.

2. In the Refresh Variables dialog, do the following:

a. For Include Budget?, select Yes to include budget data orNo to exclude it.

NOTE: The Include Budget? option does not display if there are no RF_Forecast records
for which RFDType = Budget.

b. For Select RFPeriod for Forecast, available selections include RFPeriods prior to the current
period that have ForecastFinal or DeductionResult records. The default is themost recent
of these periods. Click Choose Value and select the desired period.

NOTE: If there is only one period of forecast data available, the current period is
available for selection.

c. (Optional) If you want to include an RFGroup column from the RFGROUP table, then from
the Select RFGroup Column drop-down, select the desired column. If needed, select any
additional options that your selection provides (e.g., if you selected Entity, you are
presented with the option to select one or more Entities).

d. From the Select Scenario drop-down, select the desired scenario.

e. Click OK.

The report displays data for the selected Scenario, RFPeriod, and RFGroup. The report data
is filtered by your RF_Forecast security permissions.

3. Upon open, the report displays the default view. To change to a different view, in theMain ribbon
tab, in theWorkbook Options section, click Change View and select the desired view:
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4. To quickly access the Profitability, Utilization, or Labor Utilization sections, in theMain ribbon tab,
in theWorkbook Options section, click GoTo > Ratios and select the desired section.

Using the EBIDA Summary report
The EBIDA Summary report provides transparency into your organization’s operations by displaying
EBIDA values of amount and percentage that provide a real measure of performance against targets. This
information can serve as an indicator of your organization’s financial health.

EBIDAmeasures revenues minus expenses (profitability) but excludes the non-cash expenses like
deprecation and interest.

Use the report to monitor your EBIDA Amount and EBIDA Percentage for various selected periods of
time, including Annual, Quarterly, Monthly, and Year To Date (YTD).

Run the EBIDA report at least monthly.

To access the EBIDA Summary report:
1. In the RF Admin or Rolling Fcsting task pane under Reporting, double-click EBIDA Summary.

2. In the Refresh Variables dialog, do the following:

a. For Include Budget?, select Yes to include budget data orNo to exclude it.

NOTE: The Include Budget? option does not display if there are no RF_Forecast records
for which RFDType = Budget.
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b. For Select RFPeriod for Forecast, available selections include RFPeriods prior to the current
period that have ForecastFinal or DeductionResult records. The default is themost recent
of these periods. Click Choose Value and select the desired period.

NOTE: If there is only one period of forecast data available, the current period is
available for selection.

c. (Optional) To include any RFGroup columns from the RFGROUP table, from the Select
RFGroup Column drop-down, select the desired columns. The default is to include all
RFGroup columns.

d. From the Select Scenario drop-down, select the desired scenario.

e. Click OK.

The report displays data for the selected Scenario, RFPeriod, and RFGroup. The report data
is filtered by your RF_Forecast security permissions.

3. Upon open, the report displays the default view. To change to a different view, in theMain ribbon
tab, in theWorkbook Options section, click Change View and select the desired view:

The following example shows an EBIDA report with Show EBIDA Details as the selected view.
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Using the Target Variance report
The Target Variance report enables you to compare a the Actual results for a combination of financial and
metric indicators, including forecast values for theMonth and Year-to-Date.

The report is divided into the following main sections:

l KPI Metrics (requires Summary view) – Use as indicators for:

o Workload statistics [selected RFGroup statistic]

o Total Expense Per Unit

o Labor

o Expenses

o Revenue

l Per Unit Summary – Includes per unit revenue for IP, OP, Other Patient, and Total.

l PNL section

Run the Target Variance report at least monthly.

To access the Target Variance report:
1. In the RF Admin or Rolling Fcsting task pane under Reporting, double-click Target Variance

Report.

2. In the Refresh Variables dialog, click the drop-down and select a filter method:

l RptMap – Filter by the Department table’s RptMap column.
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a. For Select DEPT.RptMap (leave blank for All), click Choose Value and select the
desired RptMap.

b. Click OK.

l RFGroup – Filter by RFGroup.

a. (Optional) For Select RFGROUP (Leave blank for All), click Choose Value and select
the desired RFGroup.

b. For Select Period to Compare, click Choose Value and select the desired fiscal
period.

c. From the Select Scenario drop-down, select the desired scenario.

d. Click OK.

3. Upon open, the report displays the default view, which is Summary. To change to a different view,
in theMain ribbon tab, in theWorkbook Options section, click Change View and select the
desired view:

The following example shows the Target Variance report with Summary as the selected view.
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Using the Month End Variance report
Use theMonth End Variance report to review and analyze variances in compared data, and to enter
comments about the variances and any course correction actions that need to be taken. If your
organization has Axiom Performance Reporting, you can also drill down to details from theMonth End
Variance report.

NOTE: The drill-down on data function is not enabled for this release.

The report is available from the RF Admin and Rolling Fcsting task panes.

� 1. Open the report
To open the report:
In the RF Admin or Rolling Fcsting task pane under Reporting, double-clickMonth End Variance.

� 2. Filter the report
Options in the Filters panel control the type and source of data displayed in the report. The first section
in the panel selects the RFGroup source of the data. The second section, ViewOptions, determines which
sections display in the report.

To filter the Month End Variance report:
1. In the Filters panel under Filter Options, from the Select RFGroup drop-down, select the

RFGroup.

2. Under View Options, from theWhich items do you want to view? drop-down, select one of the
following:

l All Items – The report will include items that do not require comments.

l Required Comments Only – Only items that you need to respond to will appear in the
report.

3. To display any of the following sections in the report, select the corresponding check box:

l Action Plan – Displays a column of fields for entering an action plan to address the
variance.

l Rate Volume Variance – Displays the Rate Volume Variance data columns to the right of
the comments/action plan columns.

l Year-to-date – Displays the year-to-date columns at the right end of the report.

4. To apply selections, click Apply.

To change existing filter selections:
l To clear a single filter option, click the x next to the drop-down.
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l To clear all the selected filter options, click Clear All.

The filter criteria associated with the RFGroup you selected display above the report.

� 3. Enter variance comments and action plans
To enter variance comments:

TIP: If the report is long, you can collapse the sections to view only those items that require your
input: in the Filters panel under View Options, from theWhich items do you want to view? drop-
down, select Required Comments Only.

1. In the Variance Explanation column fields, enter variance comments for the required items.
Required items are indicated by a red triangle inside a yellow rectangle:

2. To add course correction information or action items to any variance explanation, enter this
information into the corresponding Action Plan column fields.

NOTE: If you do not see the Action Plan column to the right of the Variance Explanation
column, then in the Filter panel, select View Options > Action Plan, and then click Apply.

3. Click Save, and then in the confirmation dialog, click OK.

� 4. Drill down to details
If your system is integrated with Axiom Performance Reporting, you can use the preconfigured report
drills.

� About drilling in the report

IMPORTANT: When drilling in this report, if the Budget Planning feature and its associated tables are
not present, certain drill paths might produce errors. For example, if you were to drill into salary
accounts where data is expected to come from a Budget Planning table named Bud_Pay12_yyyy and
the table does not exist, you would receive an error message.

Drills in the report are indicated by a drill icon ( ) to the left of each report row that has drillable data. As
you drill down to details, a report tab for each level opens to display the detail. Sometimes the next level
is included as a drop-down, as shown in the following example.
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l As you drill, data from Axiom Performance Reporting is displayed. When you drill down on the
report, the first drill goes to data at the department level. Drilling from the department level goes
to account level data, and then to jobcode level data, and so on, providing that there is data at
each level. Otherwise, the drilling stops where the data ends.

l Drill levels depend on the type of data you are drilling on, but generally, the drill levels available
are: Department data > account data > jobcode > revenue and usage > physician revenue >
revenue transaction detail.

l Data available for drilling is controlled by the settings in the Variance Comments Collection Setup
Utility, available to administrators and analysts.

To drill to details:
1. Locate a desired drill, and then click the Drill icon ( ). You may need to expand sections of the

report to see the available drills.

2. Do any of the following:

l In the next level tab, if there are collapsed subsections, expand them to view the next level
and to see any drills to subsequent levels.

l Move from one open level to another by clicking the level tabs at the top of the page.

3. To close a level tab, click the X at the end of the tab.
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Understanding file output options
Axiom Rolling Forecasting provides a variety of file output options to share data with people throughout
your organization. This section explains the file setup to use these features.

l Print view setup: You can set up one or more custom print views for each sheet in an Axiom file.
You can associate these print views with sheet views to automatically hide and/or format rows
and columns in the print copy.

l Snapshot setup: Users can take snapshot copies of Axiom files without requiring any advance
setup. However, if desired, you can flag certain rows and columns in the sheet to be deleted in the
snapshot copy. The primary use for this would be to delete work areas or Axiom query artifacts
that are no longer necessary in the snapshot copy.

NOTE: In reports with Excel’s expand/collapse feature enabled, snapshots need to be
generated using the Excel Client; otherwise, the columns will be hidden.

Printing an Axiom file
You can print a spreadsheet Axiom file on a per sheet basis. You can decide to print one or more sheets,
or all available sheets.

Each sheet can have one or more defined print views. The print views can be used to print different
"views" of the sheet, and to set certain standard print options such as the print orientation. For example,
for a plan file, you might have one print view that prints a "summary" view of the sheet (with certain
columns and rows hidden for printing), and another print view that prints a "detail" view of the sheet
(with all columns and rows visible).

If a sheet has no predefined print views, then the sheet can be printed using the settings defined for the
spreadsheet using standard Excel printing features. For more information on defining print settings for a
spreadsheet, see theMicrosoft Excel Help. In theWindows Client, the spreadsheet print settings are
defined in theWorkbook Explorer, in the Page Setup section for each sheet.

NOTE: You can always print the file using standard spreadsheet print functionality, even if Axiom
Rolling Forecasting print views have been defined.

To print an Axiom file:
1. On the Axiom tab, in the File Output group, select one of the following:

l If you want to be able to select print views from all sheets in the workbook, click Print.
l If you want to print only the current sheet, then click the arrow to the right of the Print

button, and then click Print This Sheet.
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NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The Print Sheets dialog opens. This dialog lists the available print views for the entire workbook or
for the current sheet, depending on how you entered the dialog. To sort this list by the Sheet
Name or Print ViewName, click the column header.

Example Print Sheets dialog

NOTES:
l If a sheet does not have a defined print view, then it is listed with a print view name of

"Default," and will use the print settings defined for the spreadsheet.

l Control Sheets cannot be printed using the Axiom Rolling Forecasting printing feature,
whether they are visible or hidden. If you want to print a Control Sheet, use the
standard spreadsheet printing features.

2. In the Print Sheets dialog, select the sheet / print view combinations that you want to print.
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If you want to print all print views for all sheets, then select the check box in the column header to
select all.

If you opened this dialog by using Print This Sheet and the sheet has only one available print
view, then that view is selected by default.

3. You can also do any of the following before printing:
l View and edit the print settings. If you want to view and potentially change the print

settings for a selected view, click the View/Edit link. In the Print Options dialog, you can
change any of the print settings, for the current print job only (the changes are not saved in
the file).

l Preview a print view. If you want to preview a print view, click the Print Preview link. The
native spreadsheet Print Preview feature will open to preview the print job. Only one view
can be previewed at a time.

l Select a printer. If you want to print to a different printer than your default printer, click
Choose Printer at the bottom of the dialog. In the Printer Setup dialog, select the printer
that you want to use, and then click OK.

NOTE: In theWindows Client, the printer is always your default printer unless you
change it for a particular print job. In the Excel Client, the printer starts as your default
printer, but if you change the printer for a print job, the changed selection will be
remembered for any future print jobs in the current session.

4. Click Print.

The selected items are printed.

Print Options dialog

The Print Options dialog displays the print settings for the current print view. If desired, you can edit
settings for the current print job only. Any changes madewill not be saved in the file.

NOTE: Print options are read-only when using the Print Plan Files option to print multiple plan files.

This dialog displays all of the settings that will be applied to the print job, whether the setting is defined
in the associated Print tag or inherited from the spreadsheet settings. If a setting is blank, then that print
option is not defined and will not be applied to the print job.

Item Description

Print ViewName The name of the current print view.

Print View Options
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Item Description

ViewName The name of the sheet view to be applied when printing. These are the
same sheet views that are available from the Change Viewmenu.

For example, if the sheet view is configured to hide columns or rows,
those columns and rows will be hidden in the print copy. Row and
column sizing is also applied.

Paper Size The paper size for the print job, either Letter or Legal.

Orientation The print orientation for the print view, either Portrait or Landscape.

Repeat Rows The rows to repeat at the top of the page. Rows must be specified as a
range; for example: 1:3.

Repeat Columns The columns to repeat at the left of the page. Columns must be
specified as a range; for example: A:C.

Item Description

Fit To Pages Wide The number of pages on which to fit the print area. For example, if you
want the print area to fit on one page, specify 1.

Percent Zoom The percent zoom to apply to the print range. Specify the number
without a percent sign. For example, to zoom by 90%, specify 90.

Scaling

Item Description

Left Header Header text to display in the left-hand side of the header.

Center Header Header text to display in the center of the header.

Right Header Header text to display in the right-hand side of the header.

Left Footer Footer text to display in the left-hand side of the footer.

Center Footer Footer text to display in the center of the footer.

Right Footer Footer text to display in the right of the footer.

Headers and Footers

Printing multiple plan files
You can print multiple plan files in batch by using the Print Plan Files feature. You can select multiple
plan files within a file group, and then select one or more print views for each plan file. The available print
views for each plan file are based on the template that was used to create the plan file.
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To print multiple plan files from a file group:
1. On the Axiom tab, in the File Output group, click the down arrow to the right of the Print button,

and then click Print Plan Files.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

TIP: If you have access to the file group menu for a file group, then you can access Print Plan
Files from the file group menu. In this case, the current file group is pre-selected in the dialog.

2. In the Print Plan Files dialog, use the File Group list to select the file group that contains the plan
files that you want to print.

Only one file group can be printed at a time. Once a file group is selected, the dialog displays a list
of the available plan files.

3. In the Select plan files to print section, select the plan files that you want to print.
l You can sort and filter the list using standard Axiom grid functionality to find the plan files

that you want to print.

l To select multiple plan files at once, highlight the plan files, and then right-click and select
Select. If you want to print all plan files that currently display in the dialog, select the check
box in the header row.

Once at least one plan file has been selected, you can select which print views to print.

4. In the Select views to print section (at the bottom of the dialog), select the views that you want
to print. You must do this for each source template used for the selected plan files.

l Click the Select print views link.

l In the Select Print Views dialog, select the sheet / print view combinations that you would
like to print, and then click OK.

If you want to see the settings that will be applied to the print job, click the View link. Print
settings are read-only in this context.
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NOTE: All template sheets are listed in this context (except for Control Sheets), including
sheets that you may not normally see in plan files because they are hidden. If you select
a sheet that is hidden in one of the selected plan files, it will not be printed. Amessage
will inform you of the unprinted sheet when the printing process is complete.

l Repeat this process for each source template.

If all of the selected plan files were built using the same template, then there will be only one
template listed. If the selected plan files were built using multiple templates, then multiple
templates will be listed. The print selections for each template will only apply to the plan files that
were built using that template.

5. If you want to print to a different printer than your default printer, click Choose Printer at the
bottom of the dialog. In the Printer Setup dialog, select the printer that you want to use, and then
click OK.

NOTE: In theWindows Client, the printer is always your default printer unless you change it
for a particular print job. In the Excel Client, the printer starts as your default printer, but if you
change the printer for a print job, the changed selection will be remembered for any future
print jobs in the current session.

6. Click Print.

The selected plan files are printed, using the print view selections.

If a selected print view is not found in a target plan file, a message displays at the end of the process,
listing the affected plan file and the relevant sheet / print view. This may occur if the print views in either
the template or the plan file have been modified after plan file creation.

Taking a snapshot copy of an Axiom file
You can take a “snapshot” of a spreadsheet Axiom file, so that you can save a copy as a normal Excel file
and then open it in Microsoft Excel (without needing Axiom Rolling Forecasting). For example, you may
want to send a copy of a report to someone that does not have access to Axiom Rolling Forecasting.

When you create a snapshot of an Axiom file, the file is copied as an XLSX file, and the following occurs:
l All Control Sheets and any hidden sheets are automatically removed. You can choose whether to

include all remaining sheets, or only the active sheet.
l All Axiom formulas are replaced with values. You can choose whether to retain Excel formulas, or

replace them with values. If Excel formulas are preserved, certain formulas will be replaced with
values if they reference sheets or cells that are deleted as part of the snapshot processing.

l Rows and columns flagged for delete are deleted.

Due to the file format, any VBA macros in the file are also removed.
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To take a snapshot of an Axiom file:
1. Open the file in Axiom Rolling Forecasting.

2. On the Axiom tab, in the File Output group, click Snapshot.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The Snapshot File dialog opens.

3. In the Formula Replacements section, select one of the following:

l Convert All Formulas (default): All formulas are replaced with values.

l Retain Excel Native Formulas: All Excel formulas in the spreadsheet will be retained as is,
with one exception. If a cross-sheet formula references a sheet that will not be present in
the snapshot (depending on the Sheets To Snapshot setting), that formula will be replaced
with values.

NOTE: If the file contains a pivot table, this option must be selected in order for the
pivot table to work in the snapshot copy.

4. In the Sheets to Snapshot section, select one of the following:
l Limit to Active Sheet (default): Include only the active sheet in the snapshot.
l All Sheets In File: Include all sheets in the file (except any Control Sheets and hidden

sheets, which are always removed).

5. Click OK.

The snapshot file is created and is opened in Axiom Rolling Forecasting. The navigation tab for the file is
titled either Sheetname_snapshot (if the snapshot contains only one sheet) or FileName_snapshot (if
the snapshot has multiple sheets). You can now use Save As features to save the file locally or to a
network location.

NOTE: If you are using the Excel Client and you want to save a copy of the snapshot as a PDF file, you
can use standard Excel functionality to do so. Use File > Save As, and then select PDF as the file type.
This is an Excel-specific feature that is not available in theWindows Client.

If you want to email a snapshot to someone directly, you can use the E-Mail Workbook feature. This
creates a snapshot and attaches it to an email (instead of opening it in Axiom Rolling Forecasting).

Emailing a snapshot of an Axiom file
You can email a snapshot of a spreadsheet Axiom file using the E-mail feature. Axiom Rolling Forecasting
creates a snapshot copy of the file and attaches it to an email. The copy can then be viewed outside of
Axiom Rolling Forecasting by someonewho may have no access to the system. When you use this
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feature, Axiom Rolling Forecasting creates a snapshot copy of the file just like it would if you used the
Snapshot feature.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the file
using the Axiom Rolling Forecasting Scheduler email service. Note that the Scheduler email service does
not support HTML format for email.

NOTES:
l The name of the emailed file is either Sheetname_snapshot (if the snapshot contains only one

sheet) or FileName_snapshot (if the snapshot has multiple sheets). The name cannot be
changed.

l You can also email snapshot copies using the File Processing feature. File processing is typically
used when you want to automate the process and employ multipass processing to send the
same file to different people using different data. The E-mail feature is best used to send "one-
off" snapshots as needed.

To email a snapshot copy of an Axiom file:
1. Open the file in Axiom Rolling Forecasting.

2. On the Axiom tab, in the File Output group, select E-mail.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The E-mail Active Workbook dialog opens.

3. For Send As, select Snapshot.

4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

l Axiom Mail Service: Send the email using the Axiom Rolling Forecasting Scheduler email
service.

5. Complete the following Snapshot Options in the dialog:

Option Description

Send file as Select XLS, XLSX, XLSM, or PDF. XLSX is selected by default.

End User's Guide Axiom Rolling Forecasting │ 114



Option Description

Include Select one of the following:

l Entire Workbook: All sheets are included in the snapshot (except
Control Sheets and hidden sheets, which are always removed).

l Active Worksheet Only (default): Only the active worksheet is included
in the snapshot.

Formulas l Convert All Formulas (default): All formulas are converted to values.
l Retain Excel Native Formulas: Axiom formulas are converted to

values, but Excel formulas are left as is. Note that if an Excel formula
references a sheet that is not included in the snapshot, that formula
will be converted to a value.
NOTE: If the file contains a pivot table, this option must be selected in
order for the pivot table to work in the snapshot copy.

This option does not apply if PDF is the selected file type.

6. Click OK.

If you selected to send the file using your default email client, then a new email message opens, with the
snapshot file attached. You can then specify the recipient, subject, and body text for the email, and then
send it.

If you selected to send the file using the Axiom mail service, then an E-Mail dialog opens so that you can
specify the recipient, subject, and body text for the email. In the address boxes (To, Cc, and BCC), you
can either type an email address, or click the button to select an Axiom Rolling Forecasting user. If you
select a user, the email will be sent using the user's email address as defined in Axiom Rolling Forecasting
security. When you click OK, the email settings are saved to the database, to be sent the next time the
Scheduler SMTP Email Delivery task is run.

Emailing a hyperlink to an Axiom file
You can email a hyperlink to a spreadsheet Axiom file using the E-mail feature. Axiom Rolling Forecasting
creates a URL hyperlink to the file and includes it in an email. The email recipient can click on the link to
launch the system and open the file directly, assuming that the recipient is an Axiom Rolling Forecasting
user who has rights to access the file.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the file
using the Axiom Rolling Forecasting Scheduler email service. Note that the Scheduler email service does
not support HTML format for email.
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NOTES:
l Alternatively, you can obtain a URL to an Axiom file using a variety of ways and then paste it

into an email that you createmanually. For example, you can use GetDocumentHyperlink or
right-click a file in Axiom Explorer to obtain a URL. The email hyperlink feature is provided as a
convenience to quickly send a hyperlink to the current file.

l The email hyperlink feature cannot be used to send a hyperlink to open a form-enabled file as
an Axiom form; the source file will always be opened as a spreadsheet.

l The hyperlink included in the email uses the same format as hyperlinks generated using
GetDocumentHyperlink, including the differing URL format for systems using SAML or
OpenID Authentication.

To email a hyperlink to an Axiom file:
1. Open the file in Axiom Rolling Forecasting.

2. On the Axiom tab, in the File Output group, select E-mail.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The E-mail Active Workbook dialog opens.

3. For Send As, select Document Link.

4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

l Axiom Mail Service: Send the email using the Axiom Rolling Forecasting Scheduler email
service.

5. Optional. Complete theDocument Link Options in the dialog:

Option Description

Sheet Filter If desired, enter a filter to apply to the file when it is opened. You can type
the filter statement or use the Filter Wizard.

The filter is applied like a Quick Filter and affects any data queries in the
file. For example, Dept.Region='West'means that all data queried will
be limited to theWest region.
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Option Description

Cell Address If desired, specify the cell to bemade active when the document is
opened. For example:

Sheet1!D22

If the specified location would not be in view normally then the file will be
scrolled to that location; otherwise the file will open in its default viewwith
the cursor placed at that location.

6. Click OK.

If you selected to send the hyperlink using your default email client, then a new email message opens,
with the hyperlink included in the body text. You can then specify the recipient, subject, and additional
body text for the email, and then send it.

If you selected to send the hyperlink using the Axiom mail service, then an E-Mail dialog opens so that
you can specify the recipient, subject, and additional body text for the email. In the To and Cc boxes, you
can either type an email address, or click the button to select an Axiom Rolling Forecasting user. If you
select a user, the email will be sent using the user's email address as defined in Axiom Rolling Forecasting
security. When you click OK, the email settings are saved to the database, to be sent the next time the
Scheduler SMTP Email Delivery task is run.
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